The SI Learning Guide Series is designed to teach SpecsIntact users the concepts involved in successfully completing projects by fully utilizing all the tools provided in the SpecsIntact system. Each guide addresses a particular aspect of the system, and clearly outlines the major points a reader should understand at the completion of each chapter.

This *QuickStart* Guide provides a basic introduction to many of the concepts that will be covered in more depth in subsequent guides. It grew from a need to help new users get a fundamental understanding of SpecsIntact, but experienced users also find it helpful as a refresher course. It’s not intended to cover in-depth every aspect of using SpecsIntact, but it is a good place to begin. This guide does not cover the installation process and assumes that you already have both SpecsIntact and Master text loaded on your computer system.

You are encouraged to use these guides in conjunction with the other user tools we provide, like the on-screen Help, *QuickTours* and our Web Site resources, which are all conveniently accessible from the SpecsIntact Explorer’s Help menu.
We want learning SpecsIntact to be as painless as possible, so we've designed these guides to give you enough information to get you going successfully without overwhelming you with every possible detail.

Along the way, we'll point out key information that you should remember, and call your attention to things that you should avoid. At the beginning of each chapter, we'll outline what you need to learn from it, and at the end, we'll summarize the concepts you should have mastered.

Meet Sally

Sally will help guide you through the process of learning SpecsIntact. She'll point out the pitfalls as she prepares you to process your project!

Throughout the guide, we'll call your attention to important issues using the symbols at the left. Below is a brief explanation of what they mean:

- **Tip** — helpful hint that might make your work easier.
- **FAQ** — Frequently Asked Question — just that.
- **Note** — important point, so pay attention.
- **Caution** — the condition or action may cause problems — proceed at your own risk.
- **Stop** — means *stop* — don’t do it or you may regret it later!
In this chapter you'll learn:
♦ Point one.
♦ Point two.
♦ Point three.
♦ Point four.
♦ Point five.

What you learned from this chapter:
♦ What you learned about point one.
♦ What you learned about point two.
♦ What you learned about point three.
♦ What you learned about point four.
♦ What you learned about point five.

At the beginning and end of each chapter, Sally will outline the important points that the chapter covers. Before moving on to the next chapter, be sure you have an understanding of those points, since the subsequent chapters will build on that knowledge.

Instructions that should be followed in sequence are numbered.

Points to remember:
• Something
• Another thing
• Yet another thing

Text in bold indicates elements you will find on your screen or SpecsIntact terms:
File menu, OK button, Section

Actions appear in italics: click, select

When you see the mouse symbol, it means you can also right-click to access the function.

Support Problems Encountered Commonly

Here's where you'll find some real-life examples from our Tech Support Desk. Learning from others’ mistakes is better than making your own! The situations are real, the names are not.
What is SpecsIntact?

SpecsIntact is an automated project management system for processing standard Masters used in facility construction and provides built-in quality assurance reports and automated functions that let you adapt standardized facility construction specifications to fit your project.

Used worldwide by the National Aeronautics and Space Administration (NASA), the U.S. Naval Facilities Engineering Command (NAVFAC), and the U.S. Army Corps of Engineers (USACE), SpecsIntact makes it possible to assure quality control for project specifications from beginning to end.

So let’s get going with SpecsIntact!

A Brief SI History

1965 - Conceived by NASA
1986 - Adopted by NAVFAC
1988 - Adopted by USACE

The SpecsIntact system -- designed by NASA and managed at the Kennedy Space Center -- is used by engineers, architects, specification writers, project managers and construction managers doing business with the three supported government agencies.

Using SpecsIntact reduces the time and expense required to produce facility specifications, and helps eliminate costly construction changes due to omissions, discrepancies or improper quality controls.

How is SpecsIntact able to check the accuracy of the various elements within the specifications?

It uses a special tagging system similar to the one that tells a web browser how to display a web page. This tagging enables the system’s reports and other automated features, reducing the time required to complete your project. The quality assurance reports verify the accuracy of technical references, submittals, and other requirements. Now, you might be thinking that this tagging sounds mighty important — well it is! That’s why in the subsequent pages, you’ll learn how to get it right!
In this chapter you’ll learn:
- What makes SpecsIntact unique.
- Some of the common terms used.
- What type of files can be used.
- The main components of SpecsIntact.
- The steps involved in producing a completed Job.

If not software, then what?

One of the first basics you should know about SpecsIntact is that we refer to it as a system rather than just software.

The reason we call it a system is that it’s much more than just a specification editing tool. It allows you complete management of your projects — choosing the specifications you need from standard guide specifications known as Masters, editing those specifications to fit your project, utilizing automated processes and quality control reports, and finally, producing your completed specifications in a choice of three formats.

If you follow the editing rules, use the quality controls and automated features, you can produce a final project that is complete and accurate.

Learning the language...
If you’re new to SpecsIntact, you may find some terms unfamiliar. Learning what they mean will help you understand how the system works and how to communicate more effectively regarding your project.

Some terms you’ll encounter are unique to SpecsIntact, others are industry-related and may already be familiar to you, while still others are computer-related. Since SpecsIntact users come from a variety of backgrounds, we’ll define terms for you as we go along.

You’ll also discover that some common words have very specific meaning in SpecsIntact. For example, while working in a word processing document, you might say that you’re having trouble with a section, referring to a portion of the document. But when working in SpecsIntact, a Section is actually an entire document. To help you avoid confusion, we’ll point out SpecsIntact terms by capitalizing them and displaying them in bold when we discuss them.

Learning how to “speak SpecsIntact” makes it easier for you to fully utilize all its features and keep the Section structure correct. You’ll learn more about Section structure in Chapter 3.
The type of files you edit in SpecsIntact are called **Sections** — when you see them on your computer system, they have a file extension of `.sec`. Although they can be created from scratch, most of the time you'll be editing Section files that you copy from a **Master**.

Master Sections are formatted with the tagging (there's that word again!) necessary for SpecsIntact's automated features to work, but you must edit the content of each to fit your particular project — usually referred to as a **Job**.

You'll see two main types of folders displayed in the SI Explorer — **Jobs** and **Masters**.

By clicking one of these folders in the left pane, you can display all the Section files it contains in the right pane.

At the start, Section files are the only type your new project will contain, but as you work, you will produce other types, such as Reports and output files. The Section (.sec) files are always the “editing” copy from which the others are produced.

The **only** file type that is ever *edited* in SpecsIntact is the Section (.sec) file.
When you process and print a Job, you produce files with the .prn file extension (you’ll learn more about processing in Chapter 5). These files are displayed in the left pane of the SI Explorer in the Processed Files subfolder under the Job. Just like the Job folder, clicking a subfolder displays its contents in the right pane. If you need to make further edits, you must always edit the Section (.sec) file, not the .prn file. When you process your Sections again, the new Processed Files will replace any previous .prn or Report files.

You can also produce processed files in two other popular formats: Microsoft Word and Adobe Acrobat. Of course, these require that you have the corresponding software on your system for the output feature to be available. These files cannot be edited in SpecsIntact — they are only for producing a final copy of your specifications in these formats. The files they produce are displayed in the SI Explorer, each type in its own subfolder under the Job.

Once I’ve processed and printed my Job creating Word files, can I edit them in Word?

Well, yes, but if you do, they must be edited like any other Word document without any of the SpecsIntact quality controls, and they cannot be returned to SpecsIntact. If you ever have to go back to that Job or Section in SpecsIntact, any changes you made through Word will be lost. It’s best to make any changes in SpecsIntact and then process and print the Job again to produce new Word files.

So, what do you see when you open SpecsIntact?
SpecsIntact has two main components: the SI Explorer and the SI Editor.

SI Explorer

Through the Explorer, you accomplish all the project management, like putting together the specifications you need, running the reports, and producing the final product. It provides a way to visually manage the entire project — or multiple projects at the same time.

Two common features you’ll find in SpecsIntact are drag-and-drop and right-clicking. For example:

- In the Explorer, you can add Sections to your Job by dragging them from either Windows Explorer, a Master or from another Job.

- You can access many common commands by right-clicking and choosing them from the pop-up menu.

As you read this guide, this symbol will identify functions that can be alternatively accessed from a right-click menu.

SI Editor

You make changes to your specifications in the SI Editor. Although it’s much more than a word processor, it does have many of the same standard features with which you are probably already familiar. But in addition, it has specialized toolbars and features to help you work more quickly, and accurately (especially using those all important tags we mentioned earlier). The Editor is opened through the SI Explorer.
So, just what is the work flow for a Job from beginning to end? Below is a brief explanation of the basic life cycle of a SpecsIntact Job.

**Start**

1. **Open the SI Explorer**
2. **Click the New Job button on the toolbar.**
3. **Enter the information in the New Job dialog box’s General and Options Tabs.**
4. **Select Sections you want for your Job using the Add Sections dialog box.**
5. **Use the SI Explorer to open each Section in the Editor.**
6. **Through the Editor, make all your changes to the Sections.**

**Finish**

1. **Use the Process and Print function to produce your finished Job.**
2. **Use the Process feature in the Explorer frequently as you edit to produce the quality assurance reports.**
3. **Use the Process feature in the Editor frequently as you edit to produce the quality assurance reports.**

As with most computer programs, there are multiple ways to perform many of the common tasks. This illustration shows one path, outlining the steps involved in using the SpecsIntact system to help you assure a quality end product.
Check-list

Before Starting a Job

Some very costly mistakes are rooted in a failure to communicate — especially when starting a new project. If you'll be responsible for starting a new job and editing the specifications, you need to be able to ask the right questions at the outset. This page contains a list of suggestions and questions offered by our Tech Support staff to get you started on the right foot.

1. Make certain you are using the most recent specifications.
2. Print the Master Table of Contents with Scope to give to your engineer for the project. It can be found in the SI Explorer with the Master Sections, and is named SCOPE.
3. The engineer should give you a list of Sections to print so that he can mark up the edits that you will be making through SpecsiIntact. At this point, you need to ask the engineer some questions before you begin.

- Will the units of measure for this project be English, Metric or Both? Should I print the Sections for mark up with both? (See the next box if only one is required.)
- Will you want me to remove any Tailoring Options that may exist? (These options are tagged for easy removal when not needed, and are usually specific to a product, region or particular agency—learn more about Tailoring in Chapter 4.)
- Do you require that the editing changes I make be shown as Revisions? (When using Revisions, the changes are tagged as added or deleted, but they are not permanent until they are executed in the Section.) This must be determined before you begin editing. To learn more about editing with Revisions, refer to Editing Techniques for Revisions found in Chapter 6.

Now you can print the Sections. It's a good idea to print one at a time and print a Submittal Register with each for the engineer’s review.

1. Select the Section in the SI Explorer’s right pane.
2. Click the Print button on the toolbar and the Print Processing dialog box will open. The recommended defaults are set for Masters, but if you need to change the setting for Units of Measure, click the Options tab.
3. On the Reports tab, check Submittal Register.
4. You can change the printer destination at the bottom of the dialog box.
5. Click the Process & Print button at the top right of the box to send the selected Section and its Submittal Register to the printer.
“I’ve been given a Section in PDF that I’m supposed to add to the Job I’m working on. Can I edit this PDF file in SpecsIntact?”

— Betty in Baltimore

Sorry Betty, but once a Section is published in PDF (or Word) you can’t edit that output file in SpecsIntact. What you need for your Job is the actual Section (.sec) file that was used to produce the PDF.

What you learned from this chapter:

♦ SpecsIntact’s not just word processing software, but rather a system that enables both editing and processing of specifications, and includes automated features and quality controls.

♦ SpecsIntact consists of two main components: the **SI Explorer** and the **SI Editor**. Through the Explorer, you accomplish all the project management and processing, while the Editor allows you to edit the content of the specifications.

♦ The type of specification files that are edited are **Section** files with a file extension of **.sec**.

♦ SpecsIntact uses some specific terms that are important to learn so that you can better understand how the software works, how to maintain the proper structure for the Sections, and how to communicate with tech support and others regarding your work.

♦ The basic steps involved in bringing a project to completion are: creating the Job through the SI Explorer, editing the Sections in the SI Editor, using QA Reports, and finally processing and printing the Job through the SI Explorer.

♦ The output format for the completed Job can be in the form of the Processed files (**.prn** file extensions), Adobe PDF (**.pdf**), or Microsoft Word (**.doc**). These are output formats only and cannot be directly edited through SpecsIntact. PDF and Word require the corresponding software to produce.
In this chapter you'll learn:
- How to start a new Job.
- How to add Sections to your Job from different sources.
- How to create a new Section using a template.

The time has arrived for you to start your first Job in SpecsIntact!

From the SI Explorer:
1. Click the green folder on the toolbar, or click the File menu, then New | Job.
2. The Create New Job dialog box will open.

The fields that are circled are those that you are required to complete to set up your Job.
In addition to the General screen, the New Job dialog box has three other tabbed screens — Specifiers, Options and Comments.

The Options tab contains the settings that control Units of Measure, Revisions, the CSI MasterFormat Version and the Automatic Paragraph Numbering for your Job. The default for a new Job is set for English, Revisions turned on, CSI MasterFormat 2010 and with the Automatic Paragraph Numbering set as Numeric.

The Specifiers and Comments Tabs do not contain any required fields, but they provide areas you can use to track additional information about your Job.

All these screens can be accessed at any time by clicking the File menu and choosing Properties.
Required Fields

Rules & Restrictions

- **Job Name** — identifies your Job in both the SI Explorer and Windows Explorer, and is printed in the top right corner of each page of your Job.
  
  **Rules:** The Job Name can’t contain any symbols or spaces, and it can’t be longer than sixteen characters. It automatically appears in **UPPERCASE** letters. The name can contain numbers.

- **Job Title** — prints in the upper left corner of each page in your Job. Although it is not visible in the SI Explorer, you can display it by placing your mouse pointer over the Job Name in the left pane.
  
  **Rules:** The Job Title can’t contain more than 64 characters. It can contain numbers, symbols, spaces, and both upper and lower case letters.

- **Source** — Isn’t used as often today, but remains in order to support backward compatibility. The Source indicates the original source of the specifications used in your Job, which can be described in any format. Typical sources used were a CCB Disc # or web download. This gives you a way to keep track of where your Sections originated.
  
  **Rules:** This information is only required if the corresponding option is checked on the **Setup menu | Options | General** tab.

- **Primary Master** — displays the Primary Master chosen during installation. A different Primary can be chosen for the Job from among your currently connected Masters, which are listed in the pull-down menu. You can also connect additional Masters, or change your default Primary Master, by clicking the **Connect Masters** button just below the box.

- **Submittal Register Format** — uses the **Primary Master** you’ve selected to set the proper Submittal Register Format for your Job. If you want to use an old Submittal Format for one of the agencies, you must **uncheck** the box. If you want to change these designations later, you can do
Adding Sections to Your Job

The **Add Sections** box is made up of two panes.

The left **Add From** pane provides four tabbed screens that you use to choose Sections you want to add to your Job from various sources.

The right **Contents** pane shows the Sections that you have selected to be added.

Why do I see two Sections already listed in the right pane when I haven’t added any to my Job yet?

These two Sections -- **01 33 00 Submittal Procedures** and **01 42 00 Sources for Reference Publications** -- are automatically added to every new Job because they are necessary for processing the **Submittals** and **References**.

If you *don’t* see the **01 33 00 Submittal Procedures** and **01 42 00 Sources for Reference Publications** Sections, then you probably are not using a complete **Unified Facilities Guide Specifications (UFGS) Master**. You should have these two Sections in your Job, so hit the **Cancel** button. Then download the full UFGS Master from the web.
Using the Add Sections Box

When either the Masters or Jobs tab is selected in the left Add From pane, the buttons at the bottom will help you:

- Display Masters, Divisions and Sections
- Select the Sections you want to add to your Job
- Add the selected Sections to the right Contents pane

An asterisk next to a Section indicates that it has already been added to the Contents pane at right.

Right-click a Section and click Undo Add Section if you want to remove it from the Contents pane so that it won’t be added to the Job.

As an alternative to using the buttons, you can double-click a Master, Job, or Division in the left Add From pane to display the contents. Double-clicking a Section adds it to the right Contents pane.

When you’ve finished selecting Sections, clicking the OK button will add them to your Job, close this box, and return you to the SI Explorer.
Adding Sections Using the Masters or Jobs Tabs

To choose Sections using either the **Masters** or **Jobs** tab, in the left pane:

1. **Click** the Master or Job from which you want to copy Sections, then **click** the **Divisions** button, or **double-click** the Master or Job.

2. **Click** the Division from which you want to copy Sections, then **click** the **Sections** button, or **double-click** the Division.

3. To copy an individual Section, **click** the Section, then **click** the **Add Sections** button, or **double-click** the Section.

You can select multiple Sections by either holding the **Shift** key (to select Sections listed consecutively) or the **Ctrl** key (for multiple non-consecutive Sections) as you click your selections in the **Add Sections** box. You can also use the **Select All** button to add every Section visible in the left pane.

---

A Word About the Unified Facilities Guide Specifications (UFGS) Master

**UFGS** Sections can be used in either **Army**, **Navy** or **NASA** projects. Fully unified Sections in **MasterFormat™ 1995** have a five digit Section name, while **Army**-specific Section names are followed with an **A**, **Navy** with **N** and **NASA** with an **S**. Fully unified Sections in **MasterFormat™ 2010** can be from three to four level Section names, while **Army**-specific Section names are followed with a **10**, **Navy** with **20**, **Air Force** with **30**, and **NASA** with a **40** as the fifth level.

---

The other two tabs in the left **Add From** pane allow you to either create a completely new Section from a **Template**, or Browse to choose Sections from your drives and network (**.sec** documents only).
Creating New Sections and Local Masters

If you need to create a new Section, you can copy one of the **Templates** provided. These templates are formatted outlines to be used as a guide so that the Section you create will have the proper structure. Basic Templates distributed with SpecsIntact are:

<table>
<thead>
<tr>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UFGSBasic</td>
<td>Unified Facilities Guide Specifications MasterFormat™ 2010 Template for Masters or Jobs. This template contains <strong>minimal</strong> bracketed options.</td>
</tr>
<tr>
<td>UFGSBasic_Auto</td>
<td>Unified Facilities Guide Specifications MasterFormat™ 2010 Template for Masters and Jobs. This template contains <strong>minimal</strong> bracketed options and can be used with <strong>Automatically Numbered</strong> (Numeric and Alphanumeric) Jobs or Masters.</td>
</tr>
<tr>
<td>UFGSBracketed</td>
<td>Unified Facilities Guide Specifications MasterFormat™ 2010 Template for Masters and Jobs. This template contains numerous bracketed options.</td>
</tr>
<tr>
<td>UFGSBracketed_Auto</td>
<td>Unified Facilities Guide Specifications MasterFormat™ 2010 Template for Masters and Jobs. This template contains numerous bracketed options and can be used with <strong>Automatically Numbered</strong> (Numeric and Alphanumeric) Jobs or Masters.</td>
</tr>
<tr>
<td>UFGSMSTR95_Auto</td>
<td>Unified Facilities Guide Specifications MasterFormat™ 1995 Template for Masters that can be used with <strong>Automatically Numbered</strong> (Numeric or Alphanumeric) Masters or Jobs.</td>
</tr>
<tr>
<td>SUPP</td>
<td>Used by the software to create the Supplemental Reference File.</td>
</tr>
</tbody>
</table>

If you’ve had past versions of SpecsIntact loaded on your computer, older versions of Section templates were not deleted from your system when you installed a newer version of SpecsIntact. In that case, you may also see the following previous versions listed: ARMYOLD, ARMYSECT, NASAOLD, NAVYOLD, NAVYSECT and UFGSMstr. These can be removed by using the SI Explorer’s **Tools** menu | **Section Templates** dialog box. **Select** the ones you want to delete from the left side of the box and then **click** the **Delete** button.
A good way to manage any new Sections that you need to create is to maintain them in a Local Master. This is a Master that you create to hold any Sections that you may want to use again in other Jobs. After you have created your Local Master and edited your specialized Sections, you can add them to any Job in the same way that you add Sections from any other Master.

Creating a Local Master is similar to creating a Job.

1. Click the New Master button on the SI Explorer toolbar, or from the File menu, choose New | Master.

2. The Create New Master dialog box has two tabs to allow you to define pertinent information about the Master that you are creating. It’s advisable to name a Local Master something that is easily recognizable to you, since it will be listed in the SI Explorer with your other Masters.

3. Click the OK button.

You can add Sections to Local Masters in the same way that you add them to a Job, or create your own new Sections by clicking the Templates tab.
Adding Templates Using the Add Sections Box

With the Templates tab selected:

1. Click the agency Template that you want to copy.

2. New Jobs default to CSI MasterFormat 2010, Select Three Levels, Four Levels or Five Levels from the drop-down box.

3. Enter a new MasterFormat™ 2010 Section Number in the pre-formatted text box (see Caution below about assigning a correct number to a new Section).

4. Click the Add Template button.

When a new Section is created, it is important that your engineer assign a correct number to it. The CSI MasterFormat 2010 Edition should be used as a reference when determining an appropriate number. This information is available online at:

http://www.csinet.org/masterformat

You cannot duplicate an existing Section Title or Section Number.

Revisions should not be enabled when using a Template to create a new Section. Make sure they are off, not just hidden on screen.

Adding a Template to your Job in order to create a new Section should not be confused with the Section Templates command found on the Explorer’s Tools menu. That function permits you to actually alter your original Templates or create new ones.
Adding Sections Using the Browse Tab

This tab allows you to search your system’s drives and network for Sections you want to add. They can be located anywhere, but they must be the .sec file type and have the standard MasterFormat™ 1995 or MasterFormat™ 2010 Section names. For example, you cannot add a Word document (.doc) using this feature. You also could not add a Section that had been renamed with additional digits/characters, like “01 33 00 Rev 1” or the word “Section” in the file name (example: “Section 01 33 00”). No other file types will be visible using this Browse feature.

With the Browse tab selected:

1 Select the Drive you want to search from the pull-down list.
2 In the Directories box, locate the folder containing the file you want by double-clicking the folders to display their contents.
3 In the Sections box, click the Section you want to copy.
4 Click the Add Sections button -- or double-click the Section.

If you choose a Section that is already part of the Job, you will be asked if you want to overwrite it. If you do, the Section that exists in your Job will be replaced by the one you selected in the Browse process.

“[I received a Section by email, and I saved it in a temporary folder. How do I get this Section into the Job I’m working on?]”
— Polly in Peoria

The correct way to add a Section to your Job is through the SI Explorer’s Add Sections function. After you have saved a Section on your system, use the Add Sections box’s Browse tab to locate the Section and add it to your Job.
Adding More Sections to Your Job

You can always return to the Add Sections box at any time to add more Sections to your Job. Just click the button on the SI Explorer’s toolbar, or from the File menu, click Add Sections.

Another quick and easy way to add more Sections to a Job is to use the drag & drop feature in the SI Explorer.

1. In the left pane, click the Job you want to copy from to display its contents in the right pane.
2. From the right pane, select the Sections you want to copy and drag them to the Job folder you want to copy to in the left pane.

What you learned from this chapter:
- How to use the Create New Job box to enter the required information to set up a new Job.
- How to use the Add Sections box to choose Sections for your Job from Masters or other Jobs.
- How to add a Section Template in order to create a new Section.
- How to Browse your system drives and network to locate other Section files you want to add to your Job.
In this chapter you’ll learn:
♦ The correct format for a Section.
♦ Proper tagging methods.

In order for SpecsIntact’s automated features to make your work easier and your completed project accurate, you need to understand and follow some important formatting guidelines.

Each Section begins with a line that contains the Section <SEC> tag followed by one or more meta <MTA> tags (this line is not visible when tags are hidden, and it is not printed). It is followed by the Section Number <SCN>, Section Title <STL> and Date <DTE>, each on a separate line as illustrated below. The teal triangle indicates a Note that is hidden. When displayed, this Note at the beginning of the Section contains a banner that defines the origin of that Section (more on Notes in Chapter 4).

Character Limits

<table>
<thead>
<tr>
<th>Character</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section Title</td>
<td>120 Characters</td>
</tr>
<tr>
<td>Section Number</td>
<td>14 Characters</td>
</tr>
<tr>
<td>Date</td>
<td>5 Characters</td>
</tr>
</tbody>
</table>

Following the Section header information, the body of the Section is broken down into three Parts that conform to the Construction Specifications Institute's (CSI) standard three-part format.

Some of the biggest and most time-costly mistakes made by new users of SpecsIntact come from ignoring the structure and tagging requirements. If you learn these, your editing tasks will be much easier!
Parts & Subparts

Articles, Paragraphs and Subparagraphs

Think of Section structure like a numbered outline. Each Section has three major top-levels called Parts.

Parts are not automatically renumbered since they are considered inseparable or one in the same, PART 1 GENERAL, PART 2 PRODUCTS and PART 3 EXECUTION will appear within the <TTL> Tags.

Each PART contains a specific type of information:

- **PART 1** covers specific administrative and procedural requirements unique to the Section.
- **PART 2** describes the quality of items required for the Job.
- **PART 3** details preparatory actions and explains how the products outlined in PART 2 are to be used in the Job.

Each of a Section’s three PARTS is further divided into three Subpart levels (but no more than three!). The Subpart numbers are automatically generated by SpecsIntact and placed inside the beginning Subpart tag as well as on the outside of the Subpart tag. Since the numbers are automatically generated, neither of the numbers can be edited.

The first Subpart level under a PART is known as an Article. An Article’s number is made up of the PART number (either 1, 2 or 3) followed by a period and the two-digit Article number. In addition, the title must be UPPERCASE and surrounded by Title tags <TTL>.

Here’s what an Article under PART 1 would look like:

```
<SPT =1.1>1.1 <TTL>REFERENCES</TTL>
```
Parts & Subparts

Articles, Paragraphs and Subparagraphs

The second and third level Subparts follow the same numbering outline — adding a period and a number for each level, with their titles surrounded by Title tags <TTL> — but they appear in Title Case Letters instead of UPPERCASE.

A second level Subpart is called a Paragraph. An example of a Paragraph under Part 2 would look like this:

```
<TTL>Properties of Sections</TTL>
```

A third level Subpart is called a Subparagraph. An example of a Subparagraph under Part 3 would look like this:

```
<TTL>Cellular Metal Floor Deck Units</TTL>
```

Although you can add a fourth, fifth and sixth level subpart, the agencies discourage you from using them. If additional levels are needed under a Subparagraph, then use letters and numbers (surrounded by <LST> and <ITM> tags), as sited in the UFC 1-300-02, Appendix A and illustrated below:

```
1.1.1.1 Subparagraph
   a. Text
      (1) Text
         (a) Text

1. Text
```

These extra levels will not be renumbered by SpecsIntact the way Subpart levels are, so if you make any changes, you must renumber them manually.

Caution: Use sparingly!

When switching between Numeric and Alphanumeric Numbering this format will not translate to the correct format and will not automatically renumber.

This is because a combination of List <LST> and Item <ITM> tags are used and not supported by the Alphanumeric format.

By now, you may be wondering about those funny looking little angle brackets < > with the letters in between. User, meet the Tags! As we mentioned earlier, without the tagging, SpecsIntact can’t do its job. Everything, E-V-E-R-Y-T-H-I-N-G in SpecsIntact is tagged. The Editor gives you a special row of buttons for inserting the tags — they are not typed manually. Without proper tagging, the built-in quality assurance reports and Job processing cannot work properly.

In the next few pages, we’ll give you some foundational information to help you understand and use tags correctly. The illustration on the next page shows the structure of a PART with tags and numbering.
Notice that **PARTS** have their own tag — `<PRT>` — but **Articles**, **Paragraphs** and **Subparagraphs** all share the same **Subpart** tag — `<SPT>`. The way you can tell what level a Subpart tag represents is by looking at the level number contained inside the tag, such as `<SPT =1.1.2>`. This would represent **PART 1**, **Article 1**, **Paragraph 2**.
Tags

The Keys to SpecsIntact

You can’t successfully use SpecsIntact without understanding and using the tags correctly — so don’t even try! In the long run, taking time now to learn about tagging will pay off in the long run.

The tagging system used in SpecsIntact is similar to its better-known relative, HTML (Hypertext Markup Language) that makes web pages display correctly in your web browser. In much the same way, SpecsIntact uses tagging to distinguish between all the different elements in a Section.

On the next page, we’ve listed some basic tagging rules that you should keep in mind. But before we get into those, below is the basic anatomy of a tag.

Most tags come in pairs — the beginning and ending tags encompass the information that they define. Notice that the end tag is distinguished by a forward slash within the tag.

\[<\text{TAG}>\text{information to be tagged}</\text{TAG}>\]

While the tags most immediately surrounding information identify it, that information is also contained within other higher level tags that have a relationship to it as well.

Think of it like a family tree: Mary is tagged as \(<\text{wife}>\) inside the \(<\text{marriage}>\) tags, but she is also tagged with \(<\text{mom}>\) tags, too. Outside of the marriage tags, in her extended family, she carries other tags like \(<\text{daughter}>\), \(<\text{sister}>\), \(<\text{grand-daughter}>\) and so on. So it is with tagged elements in your specifications: a measurement, for instance, may also be within tags for text, Subparagraph, Paragraph, Article, Part, and ultimately, Section.

With tagging relationships in focus, your editing will go more smoothly!
Tags Rules

Some Basics

Every set of tags either completely encompasses another set, or the set is completely contained within another set of tags. For example:

- **TXT tags inside**: `<TST><TXT>text text text</TXT><TST>`
- **TST tags outside**: `<TST><TXT>text text text</TXT><TST>`
  
  **OR**

- **TST tags inside**: `<TXT><TST>text text text</TST></TXT>`
- **TXT tags outside**: `<TXT><TST>text text text</TST></TXT>`

**BUT NOT**

- **TST and TXT tags are never interlinked**

Tags are not typed, they are inserted using either the corresponding button on the tags bar of the SI Editor, or by using the **Insert** menu and choosing the tag you want from the drop-down box. Inserting tags using these methods insures that they are placed correctly and that both beginning and ending tags are used.

- All content in a Section must be tagged.
- Every **Section** must begin with a `<SEC>` tag and end with a `<SEC>` tag.
- The `<SEC>` tag is followed by a meta tag line: `<MTA NAME=SUBFORMAT CONTENT=NEW/>
- All three **Parts** must begin with a `<PRT =#>` tag and end with a `<PRT =#>` tag.
- Every **Article** must begin with a `<SPT =#.>#` tag and end with a `<SPT =#.>#` tag.
- Every **Paragraph** must begin with a `<SPT =#.#.>` tag and end with a `<SPT =#.#.>` tag.
- Every **Subparagraph** must begin with a `<SPT =#.##.#.#>` tag and end with a `<SPT =#.##.#.#>` tag.
Typical Part, Subpart and Title tag lines look like this:

<pre><tt>&lt;PRT =1&gt;&lt;TTL&gt;PART 1  GENERAL.&lt;/TTL&gt;</tt></pre>

Notice PART 1 precedes the title since they are inseparable.

<pre><tt>&lt;SPT =1.&gt;1.1  &lt;TTL&gt;REFERENCES&lt;/TTL&gt;</tt></pre>

The end tag for an Article appears when the numbering goes to the next Article number in sequence. This is also true for Paragraphs and Subparagraphs.

<pre><tt>&lt;/SPT= 1.&gt;&lt;/PRT =1&gt;&lt;PRT =2&gt;&lt;TTL&gt;SUBMITTALS&lt;/TTL&gt;</tt></pre>

The end tag for a Part appears just prior to the beginning tag for the next Part, and on the same line. Do not add extra lines between them.

All end tags for Articles, Paragraphs, and Subparagraphs must appear on the same line before the end tag for the Part and the beginning tag for the next Part.
The tags used in SpecsIntact are listed below in alphabetical order, followed by a brief description of each. Some, including their content, are color coded on screen for easier recognition. These colors can be toggled on or off using the Editor’s View menu.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADD</td>
<td>Additions (Revisions) - Green</td>
</tr>
<tr>
<td>AST</td>
<td>Asterisk</td>
</tr>
<tr>
<td>ATT</td>
<td>Section Attachment</td>
</tr>
<tr>
<td>DEL</td>
<td>Deletions (Revisions) - Red</td>
</tr>
<tr>
<td>CHG</td>
<td>Change Notice</td>
</tr>
<tr>
<td>DOC</td>
<td>Document File</td>
</tr>
<tr>
<td>DTE</td>
<td>Section Date</td>
</tr>
<tr>
<td>END</td>
<td>End of Section</td>
</tr>
<tr>
<td>ENG</td>
<td>English - Dark Blue</td>
</tr>
<tr>
<td>EOD</td>
<td>End of Document</td>
</tr>
<tr>
<td>HDR</td>
<td>Header</td>
</tr>
<tr>
<td>HL1</td>
<td>Underline</td>
</tr>
<tr>
<td>HL2</td>
<td>Italic</td>
</tr>
<tr>
<td>HL3</td>
<td>Bold</td>
</tr>
<tr>
<td>HL4</td>
<td>Center</td>
</tr>
<tr>
<td>HLS</td>
<td>Screen Highlight - Orange</td>
</tr>
<tr>
<td>INC</td>
<td>Include</td>
</tr>
<tr>
<td>ITM</td>
<td>Item</td>
</tr>
<tr>
<td>LST</td>
<td>List</td>
</tr>
<tr>
<td>MET</td>
<td>Metric - Dark Red</td>
</tr>
<tr>
<td>MTA</td>
<td>Unified Submittal Format and Automatic Paragraph Numbering</td>
</tr>
<tr>
<td>NED</td>
<td>Need Lines</td>
</tr>
<tr>
<td>NPR</td>
<td>Note Paragraph</td>
</tr>
<tr>
<td>NTE</td>
<td>Note</td>
</tr>
<tr>
<td>OAD</td>
<td>Organization Address</td>
</tr>
<tr>
<td>ORG</td>
<td>Organization</td>
</tr>
<tr>
<td>OTH</td>
<td>Other File</td>
</tr>
<tr>
<td>PGE</td>
<td>Page Break</td>
</tr>
<tr>
<td>PRA</td>
<td>Preparing Activity</td>
</tr>
<tr>
<td>PRT</td>
<td>Part</td>
</tr>
<tr>
<td>REF</td>
<td>Reference</td>
</tr>
<tr>
<td>RID</td>
<td>Reference Identifier - Pink</td>
</tr>
<tr>
<td>RTL</td>
<td>Reference Title</td>
</tr>
<tr>
<td>SBM</td>
<td>Submittal</td>
</tr>
<tr>
<td>SBS</td>
<td>Subscript</td>
</tr>
<tr>
<td>SCN</td>
<td>Section Number</td>
</tr>
<tr>
<td>SCP</td>
<td>Section Scope</td>
</tr>
<tr>
<td>SEC</td>
<td>Section</td>
</tr>
<tr>
<td>SPS</td>
<td>Superscript</td>
</tr>
<tr>
<td>SPT</td>
<td>Subpart</td>
</tr>
<tr>
<td>SRF</td>
<td>Section Reference - Violet</td>
</tr>
<tr>
<td>STL</td>
<td>Section Title</td>
</tr>
<tr>
<td>SUB</td>
<td>Submittal Key - Blue</td>
</tr>
<tr>
<td>TAB</td>
<td>Formatted Table</td>
</tr>
<tr>
<td>TAI</td>
<td>Tailoring Option - Teal</td>
</tr>
<tr>
<td>TBL</td>
<td>Table</td>
</tr>
<tr>
<td>THD</td>
<td>Table Header</td>
</tr>
<tr>
<td>TOC</td>
<td>Table of Contents</td>
</tr>
<tr>
<td>TST</td>
<td>Test Requirements</td>
</tr>
<tr>
<td>TTL</td>
<td>Title</td>
</tr>
<tr>
<td>TXT</td>
<td>Text</td>
</tr>
<tr>
<td>URL</td>
<td>Hyperlink - Dark Yellow</td>
</tr>
</tbody>
</table>
Just like every family has some unique individuals, the SpecsIntact tagging family has some as well.

Tags that carry certain attributes and perform functions are known collectively as Entity tags. Their functions vary widely, and they are included in the chart on the previous page, but here are a few examples:

When inserting a Note, instead of typing a line of asterisks, you insert the <AST/> tag to represent a line of asterisks. When you display the Notes and tags on your screen, you will see the <AST/> tag instead of the asterisk line. When you display Notes without tags visible, you will see a line of asterisks at the top and bottom of the Note. So in this case, the tag isn’t surrounding content, it is actually inserting content — the line of asterisks.

Other Entity tags are:
- <MTA/> is a dual purpose tag that designates that a Section contains the Unified Submittal Format and/or uses Automatic Paragraph Numbering.
- <END/> represents the —END OF SECTION— line.
- <EOD/> used only for the Division 00 documents to represent End of Document.
- <INC/> was once used only in Masters (primarily by Navy) to include their standard cover in every Section. Although no longer used, the tag remains due to backward compatibility.

Tailoring Options

Designated by the <TAI> tag, Tailoring Options can be a bit confusing, but they’re great time savers. They are used by the writers of the Master specifications to set aside information that you can remove completely from the Sections if it doesn’t apply to the project on which you are working. By placing it within <TAI> tags, they’ve made it easy for you to remove this information without manually editing it out of each Section in the entire Job. For this reason, tailoring is often referred to as pre-editing tool. By using the built-in features of SpecsIntact, it is possible to remove the contents of <TAI> tags from individual Sections, or from an entire Job, without ever opening the Sections in the Editor. When creating a new Job or Master the Tailoring Options Dialog box will appear so you can choose the Tailoring Options you wish to be removed. Additionally, the SI Editor’s Tailoring Dialog box will appear when opening Sections that contain Tailoring Options. You’ll learn more about using Tailoring Options in order to pre-edit the Section in both the SI Explorer and the SI Editor and you are using Revisions the Tailoring Options that are being removed will not be redlined.
SpecsIntact helps automate the use of References in your Job. This great time saver is controlled by the use of a family of tags that identify the Reference-related elements, a listing of References within each Section, and a Section listing all referenced publications. Your goal at the end is to have these lists reflect only the References actually used within your Job — a task SpecsIntact will accomplish for you during processing through Reconciliation — as long as the information is inserted and tagged properly.

We'll cover more on adding References in Chapter 4, and describe how the Processing function works in Chapter 5, but for now, here are a few basics:

In Chapter 2, we mentioned the two Sections that are automatically added to every Job because they are necessary for processing your finished specifications. One of them — 01 42 00 Sources for Reference Publications Section — lists all the sponsoring organizations (with addresses) for publications that are referenced in the Master text. During processing, this list will be used to check the Reference Publications.

Within each Section, a listing of References used in that Section is contained in Part 1 within the Reference Article (remember that an Article is a first level Subpart). You can add to this list, but you shouldn’t remove any References, since any you don’t use in your final text will be automatically excluded from the output files you produce during processing.

The Master text:

- Reference <REF> tags surround the information and other tags for each reference publication listed.
- Organization <ORG> tags enclose the name of the sponsoring organization.
- Organization Address <OAD> tags surround the address, phone, fax, email and Internet information for each sponsoring organization.

The content of the References cited in the Sections is considered part of the specifications. The 01 42 00 Section supplies contractors with information they need to order the necessary referenced publications.

The Reference Article of each Section (found in Part 1) contains:

- <REF> and <ORG> tagged information (but not <OAD>)
- Reference Identifiers <RID>
- Reference Titles <RTL>

Outside the Reference Article, you will only have Reference Identifiers <RID>.

33
SpecsIntact also automates the use of **Submittals** in your Job, which brings us to the second of the two Sections necessary to process a finished Job: the **01 33 00 Submittal Procedures Section**. This Section lists all the **Submittal Descriptions** — as well as pertinent instructions. Submittals fall into one of eleven assigned **Submittal Descriptions** (containing numbers and names) that should not be altered.

**Submittal Items** are each listed under their corresponding **Submittal Description** in the Section’s **Submittal Article** (within Part I). Only Submittal Items actually used elsewhere within the Section should be listed in the Submittal Article, and they must be identical and tagged properly to enable the system to process the information correctly. The Submittal Article can be edited.

In addition to the information contained in the Job’s Sections, another document — called the **Submittal Register** — can be produced when printing a Job if the Submittals have been correctly tagged. It lists the materials, products or items for each Submittal, and cites the **Section** and **SubPART 1**ocation where the Submittal is mentioned in the Job’s text.

You will learn more about tagging and formatting Submittals in Chapter 4, and in Chapter 6 we’ll cover more about producing the Submittal Register.
“I just finished editing six Sections of the first Job I've ever done in SpecsIntact. Now my co-worker (who’s used SpecsIntact in the past) says I should have been viewing what she called “the tags” while I was editing. I got confused by all those things mixed in with the text so I did my editing without displaying them on the screen. Was this a mistake?”

Dottie in Dallas

Yes Dottie, that was a mistake. Without the tags visible, your cursor may not be located where you think it is and you may be deleting necessary information and tagging. It’s vitally important that your tagging is correct so that all the elements within your Sections are identified properly. You will need to correct any tagging errors in those six Sections, and from now on, always edit with the tags visible on your screen.

What you learned from this chapter:

♦ Sections have three top levels known as Parts.
♦ Each Part can have no more than three lower levels known as Subparts.
♦ The three SubPART 1evels are called Articles, Paragraphs, and Subparagraphs.
♦ Parts and Subparts have specific numbering and title requirements.
♦ All information in a Section must be tagged to be identified. SpecsIntact has many different types of tags for this purpose.
♦ Most tags come in pairs with both a beginning and ending tag that encompass the information they identify.
♦ References and Submittals each use a family of tags to identify their elements and assist in processing.
♦ You should always display the tags on your screen when editing to avoid costly errors.
Editing Your Job

In this chapter you'll learn:
♦ Pre-editing using Tailoring Options.
♦ How to open a Section in the SI Editor.
♦ Toggling on-screen elements using the Toolbar.
♦ Inserting tags using the Tags Bar.
♦ How to use Revisions while editing.
♦ How to use Formatted Tables while editing.
♦ Shortcuts for removing tags and text.

The time has finally arrived! Armed with the knowledge you've gained, you are now ready to tackle editing your first Section!

Taking the printed Sections that have been marked-up by your engineer, you can now use the SI Editor to make those changes to the Section files in your Job. To do so, you always start by opening the Job in the SI Explorer.

From the SI Explorer:

1. Click your Job folder in the left pane to display the Sections it contains in the right pane.

2. Use one of the following to open the Section you want to edit in the SI Editor:
   — Click the Section once in the right pane, then click the Edit button on the toolbar,
   OR
   — Click the Section once in the right pane, then click the Sections menu and choose Edit,
   OR
   — Double-click the Section in the right pane.

Using any of these methods, the Section you select will open in the SI Editor.
Welcome to the SI Editor

Learning Your Way Around

You can access all the functions you need to do your editing by using the Editor’s menus, Toolbar and Tags Bar.

Many common commands are accessible from both the menus and the toolbar.

A number of them are familiar Windows-standard functions — such as cut, copy, and paste.

Others — such as the commands to show or hide screen elements like tags, notes and revisions — are specific to the SI Editor.

Always edit with the tags visible on the screen. You can turn tags off to check the formatting, but when you make any changes, you must see the tags. Following this rule will prevent major errors.

Use this button to toggle the tags off and on.

Using a button on the tags bar inserts a pair of the selected tag. You can either insert the tags then type the information between them, or type the information first, select it, then click the tag button to insert the tags around it.

The tags bar can be customized — you can display the tags you use frequently by clicking the down arrow at the end of the bar and checking or unchecking the tag name.
Tailoring Options

Pre-Editing Your Job

In Chapter 3, we introduced you to the concept of Tailoring — a way to pre-edit Sections when the Master text preparers have marked information with Tailoring <TAI> tags. If Sections contain Tailoring Options, you can choose to leave or remove all the information within the <TAI> tags — either throughout the entire Job, or in selected Sections — without opening any of the Sections in the Editor. This eliminates the need to manually edit this information in each Section.

It's especially important that you understand Tailoring since it is displayed by default when creating a new Job or Master. It is also important to know the 01 33 00 Submittal Procedures Section does contain agency-specific Tailoring Options that should be taken care of as soon as possible.

1. You can Tailor an entire Job by using the SI Explorer’s File menu | Tailor command.
2. You can Tailor selected Sections by using the SI Explorer’s Sections | Tailor command.

If you open a Section in the SI Editor that has Tailoring Options, the Tailoring Options dialog box will appear automatically so you can choose which options to show or hide. The Tailoring Options can also be chosen from the Editor’s View menu. There is an Option on the Tools menu | Options | Save tab where you can indicate what you want the software to do with Tailoring Options that are hidden when you close a Section — retain them, delete them, or warn before deleting. The default is set to warn before deleting.

If you do not want to permanently delete the Tailoring Options from the Section make sure to select “No” when prompted.
By looking at this example, you can see the advantage of toggling the tags off to check the formatting.

Just remember to turn them back on before you begin to edit again!

When you look at a Section with the tags hidden, only the content is visible. In this example, you see only the Section Number, the Section Title, and the Date. The teal triangle at the left margin indicates that there’s a Note hidden as well.

Here is the same information with the tags displayed. As you can see, the Section and meta tags are now visible, in addition to the tags that surround the Section Number, Section Title, and Date. The teal triangle indicates that the Note is still hidden.

Use this button to view or hide the contents of all the Notes in the Section. When viewed, the Note text appears in bold and set apart from the other text by a row of asterisks above and below.

To view the contents of a single hidden Note, click the teal triangle and the Note contents will display in a pop-up box.

Units of Measure
You can determine which units of measure (English, Metric or Both) you want to display on the screen while editing by using the Options tab of the New Job dialog box. However, if you want to change the display while editing, you can do so from the Editor’s View menu. Keep in mind you do not need to remove the type of measurements and tags that you do not use. When the Job is processed and printed, it will only contain the type of measurement that was chosen.
Begin Editing

While Tags Are Visible

This is it! You’re sitting at your computer. You have the first Section you want to edit open on-screen in the Editor. You have the printed copy that has been marked with changes by the engineer. You have determined whether or not you are required to show the additions and deletions by using the Revisions feature. The time has come to edit!

So, with the tags visible on-screen, you locate the first change indicated in your marked copy.

Here’s an exercise you can do to help you understand why it is vitally important to only edit when the tags are displayed.

1. Use the toggle tags button to hide the tags on screen.
2. Place your cursor just to the left of a Part.
3. Now use the toggle tags button again to display the tags on screen and look at where your cursor is sitting.

As you can see from this illustration, the cursor is not to the left of the Part tag as you might have expected, but is actually to the left of the ending tag for the previous Subpart.
Let's begin by learning how to add Articles, Paragraphs and Subparagraphs. As you learned earlier in this chapter each of these share the same subpart tag `<SPT>`. When adding new subparts, the outcome will depend on the placement of the cursor, so let's get started!

We will begin by adding a new Article in Part 3, which we want to be 3.1.

Since tagging varies depending on whether you are at the beginning of a Part or at the bottom we'll illustrate different scenarios for inserting Articles, otherwise known as subparts!

### Adding a New Article at the Beginning of a Part!

Place the cursor to the left of the **beginning Subpart tag** for 3.1, then press the **SPT** button on the Tags Bar.

**Before:**
```xml
<SPT =3.1>3.1  <TTL>EXISTING CONDITIONS</TTL>
```

**Place Cursor Here**

**After:**
```xml
</SPT =2.5.2><SPT =2.5><PRT =2><PRT =3><TTL>PART 3  EXECUTION</TTL>
<TTL>Sub Title</TTL>
<TXT>Text</TXT>
</SPT =3.1>3.1  <TTL>EXISTING CONDITIONS</TTL>
```

Notice in the illustration above, the new Subpart is now 3.1, whereas “Existing Conditions” becomes 3.2.
Now that we have learned how to add a new Article at the beginning of a Part, let’s learn to how to insert a new Article at the end! The new Article will be 3.9.

**Adding a New Article at the End of a Part!**

Place the cursor between the ending Subpart tag for 3.8 and the ending Subpart tag for Part 3, then press the SPT button on the Tags Bar.

**Before:**

```xml
</SPT=PRT=3> <END/>
```

**After:**

```xml
</SPT=PRT=3> <SPT=PRT=3>3.9 <TTL>Sub Title</TTL> <TXT>Text</TXT> <SPT=PRT=3> <END/>
</SEC>
```

Remember Articles, Paragraphs and Subparagraphs all share the same SPT tag!
We’ve learned how to add an Article at the beginning and end of a Part, now it’s time to learn how to add a new Paragraph! Adding new subparts will become easier as you continue to build your skills, so let’s keep going!

Adding a New Paragraph!

Place the cursor to the left of the **ending Subpart tag** for **3.9**, then press the **SPT** button on the Tags Bar.

**Before:**

```
<SEC>
  <SPT =3.9></SPT =3> <END/>
</SEC>
```

**Place Cursor Here**

**After:**

```
<SEC>
  <SPT =3.9.1>3.9.1 <TTL>Sub Title</TTL>
  <TXT>Text</TXT>
  <SPT =3.9.1></SPT =3.9.1></SPT =3.9></SPT =3> <END/>
</SEC>
```

If for some reason the numbering didn’t reflect the subpart number it should have, use the undo button on the toolbar and try again!
Your training is almost complete! The last level to learn is the insertion of a subparagraph.

**Adding a New Subparagraph!**

Place the cursor to the left of the **ending Subpart tag** for 3.6.1, then press the **SPT** button on the Tags Bar.

**Before:**

```
<k/SPT =3.6.1><SPT =3.6.2>3.6.2   <ITL>Adhesively Bonded Systems</ITL>
```

**After:**

```
<SPT =3.6.1.1>3.6.1.1   <ITL>Sub Title</ITL>
<TXT>Text</TXT>
</SPT =3.6.1.1>
```

The Unified Facilities Guide Specifications Format Standard **UFC 1-300-02** provides an example method in which the subpart numbering can extend past the fourth level. Use this method sparingly and with caution. When switching between Numeric or Alphanumeric this format will not translate to the correct format and will not automatically renumber.

This is because a combination of List `<LST>` and Item `<ITM>` tags are used and not supported by the Alphanumeric format.
Deleting Information

If you delete some of the information between existing tags, don’t delete the tags. An example would be:

<TXT>Floor covers shall be maintained in good condition.</TXT> to
<TXT> Floor covers shall be maintained.</TXT>

When you remove the words — “in good condition” — you must be careful not to remove the ending </TXT> tag.

If you want to remove this information completely, you would remove both beginning and ending TXT tags as well by doing one of the following:

1. Select all the information including both beginning and ending tags.
2. Hit the Delete key (check spacing).
   or
1. Place your cursor to the immediate left of the beginning TXT tag.
2. Hold down the Shift key while hitting the Delete key (check spacing).

- A double-click method for selecting text is illustrated in Chapter 6.
- The general rule is one blank line between paragraphs.

After you’ve edited a few Sections, it is highly recommended that you check your editing skills by running Reconciliation and the Reports to spot any errors before you’ve repeated them in every Section of your Job. If you continue to use these tools periodically as your Job progresses, you shouldn’t be faced with as many problems to correct at the end of the line when you’re trying to get your Job completed on a deadline.

Follow the procedures for using the Reports as outlined in Chapters 5 and 6, and process all the Sections in the Job (even if you haven’t edited them all). You will only need to look at and correct errors on the Reports found in the Sections you have actually edited (and ignore the others until those Sections have been edited). Correcting these along the way will save you time at the end!

A common mistake made by new users is deleting the text between tags but leaving the tags. Don’t leave behind empty tags!
**Text Replacement Methods**

**Using Brackets & Tailoring Options**

Brackets are found in the Master text. They provide you with the ability to choose among several options of information, or in some cases, empty brackets indicate a fill-in is necessary. All bracketed choices in a Section must be resolved before the final submission of the job, and they can be located by using the Bracket Replacement button on the toolbar. This function will locate each set of brackets and give you the opportunity to choose from bracketed text or enter new text.

Geotextile samples for testing. Samples shall be submitted a minimum of \([30] \[60] \[90] \[\_\_\_\] \) days prior to the beginning of installation of the geotextiles.

We discussed earlier how Tailoring Options make specification editing easier by providing a way to include or exclude blocks of information that have been enclosed in Tailoring tags by the Master specification writers. This gives you the ability to easily eliminate requirements that do not pertain to your Job without editing them manually from the Sections.

Brackets are found in the Master text. They provide you with the ability to choose among several options of information, or in some cases, empty brackets indicate a fill-in is necessary. All bracketed choices in a Section must be resolved before the final submission of the job, and they can be located by using the Bracket Replacement button on the toolbar. This function will locate each set of brackets and give you the opportunity to choose from bracketed text or enter new text.

A major difference exists when it comes to using these two functions with Revisions:

- The additions and deletions with **Brackets will** be marked as Revisions.
- When you remove **Tailoring Options**, they **will not** be marked as Revisions.

However, if you haven't used the Tailoring pre-editing options available through the SI Explorer, you may come across text like this surrounded with the `<TAI>` tags. It’s not too late to use the Editor’s Tailoring function described earlier in this chapter, or return to the SI Explorer to Tailor the Sections on the Job level. Either way, it’s meant to be a time saver!
Using Revisions

The use of the Revisions feature calls for close attention especially since it is the standard setting. Before you ever begin to edit the first Section of your Job, you need to know if you are required to show Revisions.

You use Revisions when you need to show the information that is to be added or deleted without actually executing the change. If you know that you do not have to use Revisions when you set up your Job, you can disable it from the Options tab in the New Job dialog box (discussed earlier in Chapter 2).

Just how does this feature work? Here’s a portion of text that has been edited with Revisions enabled:

<TXT>The publications listed <DEL>below</DEL> form a part of this specification to the extent referenced. The publications are referred to within the text by <DEL>the</DEL> <ADD>their</ADD> basic designation only. </TXT>

- The word “below” was deleted as well as the trailing space. With Revisions enabled, instead of actually removing the word, it was instead surrounded by <DEL> tags and displayed in red strike-through. This indicates that the text is tagged for deletion.

- The word “their” was added to replace the word “the” so that word is surrounded by <ADD> tags and displayed with green underline, indicating that they are to be added.

Avoid deleting or adding partial words!!

Doing this will make proofing redlines easier and less complex.

When I toggle the Revisions view off I have all these gaps between words and paragraphs, what am I doing wrong?

To avoid gaps you need to make sure you include trailing spaces and hard returns in your redlines. Using revisions is more complicated than editing without revisions, so you must pay close attention to what you include in the markup.

To remove tags without removing their content, you can use one of two methods either right-click and choose Remove Tags or use CTRL+M.

You will learn more about editing with Revisions in Chapter 6, by using shortcut keys, double-click method and highlighting.
Using Revisions

Reversing or Executing from the Editor

But what if you want to change something that has been marked with either **ADD** or **DEL** tags? There are functions to *reverse* each in the **SI Editor**. On the **Edit** menu, you’ll find these two commands:

- **Undelete Redlined Revisions** will *remove* **DEL** tags and *leave* the text that had been marked for deletion with red strikethrough.

  `<DEL>below</DEL>`

- **Delete Added Revisions** will *remove* the **ADD** tags and *remove* the text that had been added in green text.

  `<ADD>their</ADD>`

You can also use these two commands:

- Remove only one occurrence by *selecting* it, then *clicking* the corresponding command to reverse it.
- Remove all occurrences within a Section by *clicking* the appropriate command without any text selected.

The **Execute Revisions** command in the **Editor** makes **permanent** all changes marked using the Revisions feature. This action **cannot** be reversed by the **Undo** command, so you must be certain that you no longer need the marked Revisions.

In Chapter 5, we’ll cover how to **Execute Revisions** for an entire Job or for selected Sections from the **SI Explorer** prior to finalizing your Job.

On the **SI Editor’s** **Edit** menu, you’ll find the **Execute Revisions** command. To **execute Revisions** — both **ADD** and **DEL** — within the open Section, **click** the **Execute Revisions** command.

When marked Revisions are executed, the changes will become **permanent**, and the **ADD** and **DEL** tags will be removed along with the red strikethroughs and green underlining. The changes now appear as regular text and will carry the attributes of the tags that enclose it.

Make sure to **Backup** the Job or Local Master before using the **Execute Revisions** command! Learn more about using the **Backup** feature in Chapter 6.
Using Tables

Inserting Formatted Tables

Formatted Tables were introduced in SpecsIntact version 4.3.0.821. The use of Formatted Tables deserves close attention as they are a unique breed designed specifically for the SpecsIntact Editor. Before you begin using Formatted Tables, you need to insure everyone working with you is using v4.3.0.821 or higher.

To learn more about all of the Tables functionality, begin by going to SpecsIntact’s Help and browsing to the Insert | Table Menu.

SpecsIntact will continue to support older style tables (using TBL tags) indefinitely.

SpecsIntact’s Formatted Tables allows you to design professional Tables for organizing text and data into rows, columns and cells. To begin using Tables, go the Tables Menu and choose Insert Table or select the Formatted Table button from the SI Editor’s Tags Bar or press the F5 key.

When Inserting a Formatted Table, you have several options available. You can choose how many Columns and Rows you need as well as how many rows should be Header Rows. The Header Rows will print on each page if the table cannot fit on one page.

Don’t confuse SpecsIntact Formatted Tables with Microsoft Word® or Microsoft Excel®.
Using Tables

Using Formatted Tables

Before you begin editing a new Formatted Table, it is important to understand how they function. SpecsIntact Formatted Tables are a unique breed specifically designed for the SpecsIntact Editor. There are several menu items available while working in tables, either by choosing the Table drop down menu or by taking advantage of the right-click menus.

As you learned earlier in this chapter, the default settings are set to use Revisions, another important detail to note is how to handle Formatted Tables that require a lot of edits. Rather than having ADD and DEL Tags throughout the edited cells, consider copying the entire table and pasting it below the existing formatted table. This way the Table will be surrounded by one set of ADD tags which makes it easier to edit. Once the edits are complete remember to delete the original table!

The Edit Mode is activated by left-clicking in a cell.

There are a couple of things you need to be aware of while working in Edit Mode. When tags are present, its Color attribute isn’t visible. Also, the Merge and Unmerge features are not available from the Table Menu unless two or more cells are selected or the cell is a merged cell.

Right-click menus will make editing your Formatted Tables faster and easier, but there are some things you need to know about using these menus. The first menu is activated by simply placing the mouse cursor over the row or cell then Right-click. This is the Table Menu.

This menu provides options available for changing the entire table.
Using Tables

You can also use the second menu which is an Editing Menu. This menu allows you to perform some of the more basic editing functions as well as the Table menu as illustrated below:

How do I highlight either a row or a cell in my table?

Selecting Rows or Cells in formatted Tables can be done two ways. The first method is done by holding down the left mouse button while you drag the pointer over the text or cell. The second method you can use is to select a Row or Cell left-click on the first cell, hold down the Shift key and click on the additional cells.

In Chapter 6, we’ll give you some additional tips for using Tables.

In order to make your table editing less complicated, we recommend you turn off the View | Tags command. This goes against the general rule of keeping tags visible while editing, but it will make table editing easier. As soon as you complete your table editing, make sure to turn the View | Tags command back on. Also, wait until all the text has been entered in the table before you begin adding your tags for References, Submittals, etc.
One of the keys to using SpecsIntact successfully is correct formatting. Not only is this important for SpecsIntact to work properly, but the agencies served by SpecsIntact require it. In Chapter 3, we covered the basic three Parts of each Section, as well as Article, Paragraph and Subparagraph levels. If you need to, review this material again as you begin to edit. Keeping this structure is vital to producing a correctly formatted Job.

When editing Sections in Divisions 02 through 49, do not delete any of the three Parts, even if you do not need them. If they are not applicable to the Section, they must remain in the Job, followed on the next line by the words Not Used in title case (without a period) and surrounded by <TXT> tags.

```
<VRT =3><TTL>PART 3 EXECUTION</TTL>
<TXT>Not Used</TXT>
```

With tags hidden:

```
PART 3 EXECUTION
Not Used
```

Capitalization should be consistent throughout the Job, including the initial letter of certain specific nouns and of proper names. Some examples would be:

- **Contracting Officer** - When referring to the representative of a government agency with authority to make decisions.
- **Government** - When a government agency is a part of the contract.
- **Contractor** - When referring to the contractor who is party to an owner-contractor agreement.
Formatting Numbers:

- Spell out **feet** when no inches are used.
  
  (8 feet)
- Spell out **inches** when no feet are used.
  
  (8 inches)
- When using both **feet and inches**, it is permissible to use symbols.
  
  (8’-8”, 8’-2-1/2”)
- A complete dimension must appear on one line; do not separate.
- Standard designations must appear on one line; do not separate.
  
  (ASTM C 270, ANSI ASME A17.1)
- Use numbers whenever possible, and always for dimensions. When defining both quantity and dimensions, use the written word for quantity and the number for the dimension.
  
  (three 1/2 inch holes)
- Always use figures for degrees, percent, and money
  
  (3 inches by 5 inches, 50 degrees F (20 degrees C), 20 percent, $5.50).
- Decimals should be expressed in figures.
  
  (6.235)
- For quantities less than one, a zero should be used before the decimal point.
  
  (0.235)
- To maintain uniformity throughout the specification, fractions should be typed using individual keys rather than the limited number of fraction keys provided on standard keyboards.
  
  (1/4 and 1/2)
- Omit unnecessary zeroes in time and money references.
  
  ($200, 9 p.m.)

The following tags control text appearance:

- **<HL1> Underline**
- **<HL2> Italic**
- **<HL3> Bold**
- **<HL4> Center**

Don’t confuse these with the `<HLS>` tag which allows you to highlight text (in orange) for on-screen display or draft printing through the Editor or when publishing to PDF. This tag can be used to call attention to particular text as the specifications are being prepared. The `<HLS>` tag has no affect on the final, processed Sections.

I’ve used the highlight tag throughout my Section to draw attention to areas the Project Manager needs to review, can I remove them without having to go through the entire Section?

As a matter of fact there is! The SI Explorer gives you the capability to Remove the HLS Tags for an entire Job or selected Sections. For a Job or Sections, right-click and choose the Option to **Remove Change/Highlight Tags**.
Units of Measure and Symbols

When formatting Metric and English measurements, certain spacing works best to ensure that the formatting is right when one or the other of the measurements is hidden, especially during printing. In the following examples, the underscore _ indicates one space.

For mid-line placement:

...your text<MET>_3 meters</MET><ENG>_10 feet</ENG>_your text...

But if it falls at the start of a sentence:

   Your text<MET>_13 millimeter</MET><ENG>_1/2 inch</ENG>_your text...

Or at the end of a sentence:

...your text<MET>_3 meters</MET><ENG>_10 feet</ENG>.

Punctuation is placed outside the tags:

...your text<MET>_3 meters</MET><ENG>_10 feet</ENG>,_your text.

Symbol NO-NO List

Because of potential problems, the following should be written instead of using the symbols:

- percent not %
- degree not °
- plus not +
- minus not -
- by not X
- per not /
- at not @
When you need to insert a Note, use the NTE button located on the Tags Bar. This will insert Note <NTE> tags, Asterisk <AST/> tags, and Note Paragraph <NPR> tags, followed by the word NOTE and a colon (:). It should be inserted on a new line immediately below the previous one (no blank line between). Here’s what a Note looks like with text inserted:

```
<NTE>
<NPR>NOTE: Insert grade or class of compost suitable for the surface required. Insert local or state regulation defining class or grade of compost. Where local or state regulations do not define grade or class, insert requirements for screening to limit particle size.</NPR>
</NTE>
```

With Notes hidden, only the colored triangle symbol is visible, but clicking on the symbol will display the Note content in a box like this:

When you print with Notes visible, it looks like this:

```
******************************************************************************
NOTE: Insert grade or class of compost suitable for the surface required. Insert local or state regulation defining class or grade of compost. Where local or state regulations do not define grade or class, insert requirements for screening to limit particle size.
******************************************************************************
```
In Chapter 3, we discussed the tags that relate to References. You may need to review that information as you edit. In the following you'll find an overview of what you need to know to add or delete information and tags relating to References as you edit your Sections.

It may help you understand editing your References better if you know what the end result will be when your Job is processed.

The Reference Article of each Section will contain the following tagged information for only the References `<REF>` used in that Section:

- Sponsoring Organizations `<ORG>`
- Reference Identifiers `<RID>`
- Reference Titles `<RTL>`

RIDs and their content appear in pink:

```
<RID>A1 MS-O2</RID>  <RTL>(1994; 6th Ed) Mix Design Methods for Asphalt Concrete and Other Hot-Mix Types</RTL>
```

Throughout the rest of the Section, only the Reference Identifiers `<RID>` are used.

```
[RID]ASTM C 150</RID>,
```

If you place your mouse pointer over a RID, a tip box with its corresponding information will display:

```
```

In Chapter 5, we'll explain more about processing and what occurs to make the 01 42 00 Sources for Reference Publications Section unique to your Job, while creating a unique Reference Article in each Section.

<table>
<thead>
<tr>
<th>Character Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Organization</strong></td>
</tr>
<tr>
<td>511 Characters</td>
</tr>
<tr>
<td><strong>Reference ID</strong></td>
</tr>
<tr>
<td>30 Characters</td>
</tr>
<tr>
<td><strong>Reference Title</strong></td>
</tr>
<tr>
<td>300 Characters</td>
</tr>
</tbody>
</table>
Adding References

Remember that you learned in Chapter 3 that the only Reference-related tagged information that appears in your Section text (outside of the Reference Article) is the Reference Identifier <RID>.

Adding References has been simplified with the introduction of the SI Editor's Reference Wizard. Place your cursor where the new RID should go and click the corresponding button on the Tags Bar.

The Reference Wizard will open (if it doesn’t, go to the Editor's Tools menu, click Options, choose the References tab, and click the checkbox to use Reference Wizard). The Wizard will display the Master Reference lists in the left pane.

1. Click on the reference list you want to use to display the Organizations.
2. Double-click the Organization to display a list of its RIDs with their Titles
3. Double-click on the RID you want to insert.

If this RID and its corresponding information is not found in the Section’s Reference Article, you’ll be prompted to insert it — click Yes. It will return you to the Reference Article so that you can confirm the action. After that, scroll down in the text to where you inserted the RID to continue editing.

You can choose one or more of the listed RIDs by clicking them in the right pane. Hold the Shift key to make sequential selections. Hold the CTRL key to choose separated selections.

When you choose a Reference <REF> in the Wizard, it includes <ORG> tags surrounding the name of the Sponsoring Organization, plus RID and RTL tags. If you don't select corresponding information for these, blank RID and RTL tags will accompany your selected REF. If you select a RID, it will be accompanied by the corresponding RTL.
Removing References

Removing a Reference that you are not using in your Section is easier than adding one. Since the only Reference-related tagged information that appears in your Section text (outside the Reference Article) is the Reference Identifier <RID>, you only need to remove the unwanted <RID> tags and their contents from the text.

You do not remove anything from the Reference Article of the Section. This will be handled automatically later when you select Reconciliation during Job processing.

Having said that, there is one exception to this rule. If you are using Revisions and you’re required to show deletions in the Reference Article, you can edit it manually to accomplish this.

To check a RID against the Master Reference list:

1. Position your cursor between the RID tags.
2. Click the Editor’s Tools menu and choose Check Reference or right-click

This check occurs automatically when you add a RID to the text of a Section using the Reference Wizard.

It is very important that the RIDs in the text and in the Reference Article are identical to enable the processing to work correctly. Inserting these by using the Reference Wizard will help.

In Chapter 5, we’ll discuss what happens to References during the processing of your Job. Chapter 6 will help you make corrections based on the QA Report results.
We covered the tagging of Submittals in Chapter 3, and it's important to keep that information in mind as you edit. Here is an overview of what you need to know when editing Submittals.

Submittal tags and their content appear in blue.

It may help you understand editing your Submittals better if you know what the end result will be when your Job is processed.

The Submittal Article of each Section will contain the following information for only the Submittals used in that Section:

- **SD Numbers** and **Descriptions**
- **Submittal Items**

As you can see from the example, List `<LST>` and Item `<ITM>` tags are used to provide the proper formatting.

```xml
<LST><SUB>SD-03 Product Data</SUB></LST>

<ITM>Manufacturer's catalog data shall be submitted for the following:</ITM>

<ITM><SUB>Conduit Piping</SUB></ITM>
<ITM><SUB>Concrete Mortar</SUB></ITM>
<ITM><SUB>Brick Mortar</SUB></ITM>
<ITM><SUB>Gaskets</SUB></ITM>
<ITM><SUB>Compression Joints</SUB></ITM>
<ITM><SUB>Frames, Covers and Gratings</SUB></ITM>
<ITM><SUB>Precast Concrete Manholes</SUB></ITM>
```

In the text of the Section **outside** the Submittal Article, only the **Submittal Items** are used.

```xml
<SUB>Cable Supports</SUB>
```

This creates a unique Submittal Article for each Section and allows the information to be extracted for the **Submittal Register**.

In Chapter 5, we'll explain more about processing, what occurs in the **01 33 00 Submittal Procedures Section**, and how a **Submittal Register** is produced.
Submittals

There are eleven different categories for Submittals, called Submittal Descriptions. They are identified by an SD Number followed by the Title.

These are found only in the Submittal Article of each Section, with the Submittal Items listed under each. In the text of the Section, only the Submittal Items are entered, exactly as listed in the Submittal Article, and surrounded by <SUB> tags.

A Submittal Classification indicates when Government approval is required for a Submittal Item, and appears only in the Submittal Article. If a Submittal Item referenced in the text requires approval, then its listing in the Submittal Article should be followed by a semi-colon, one space, and a set of <SUB> tags containing the letter G as illustrated below. Make sure it is placed inside the same set of <ITM> tags as the Submittal Item. If the Submittal Item has no classification it is considered to be For Information Only.

<ITM><SUB>Fluorescent lamps</SUB>; <SUB>G</SUB></ITM>

Valid Submittal Classifications

<table>
<thead>
<tr>
<th>SpecsIntact Code</th>
<th>Codes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Code</td>
<td>FIO</td>
<td>For Information Only</td>
</tr>
<tr>
<td>G</td>
<td>GA</td>
<td>Government Approval</td>
</tr>
<tr>
<td>D</td>
<td>DA</td>
<td>Designer of Record Approval</td>
</tr>
<tr>
<td>C</td>
<td>CR</td>
<td>Government Conformance Review of Design</td>
</tr>
<tr>
<td>R</td>
<td>DA/CR</td>
<td>Designer of Record Approval Government Conformance Review of Design</td>
</tr>
<tr>
<td>A</td>
<td>DA/GA</td>
<td>Designer of Record Approval Government Approval</td>
</tr>
</tbody>
</table>

Reviewers also are only listed in the Submittal Article. If you need to indicate a reviewer, you do so within the same set of <SUB> tags. Following the Classification G, use one separator (you can use either a space, a comma, a pipe symbol (|), or a dash) and insert up to five characters.

<ITM><SUB>Fluorescent Lamps</SUB>; <SUB>G A/E</SUB></ITM>
Adding Submittals

Remember that you learned in Chapter 3. Submittal Items are listed under their corresponding Submittal Descriptions (containing SD numbers and names) within PART 1 below the Submittal Article and surrounded with a set of Submittal tags <SUB></SUB> and within a set of Item tags <ITM></ITM>.

Submittal Items that appear in Submittal tags below the SD Numbers should be used in only one principal subpart of the technical Section, either as an Article, Paragraph, Subparagraph, or within the text. They are not case sensitive.

To insert the Submittal tags, use the Submittal Key button.

Removing Submittals

Unlike the Reference Article, you do edit the Submittal Article. Therefore, when you remove a Submittal Item from the Submittal Article you must also remove it from the text (along with the beginning and ending submittal tags <SUB></SUB>) and vice versa. If you remove a Submittal Item from the text, then you must remove it from the Submittal Article (along with the tags).

In some instances you may not need a particular Submittal Item, but do need to keep the supporting text. As stated above, delete the Submittal Item from the Submittal Article first (along with the tags). Once that is done, locate the supporting Submittal Item found in the body of the Section. But in this case, rather than deleting the entire Submittal Item you’ll only need to remove the beginning and ending submittal tags <SUB></SUB> as outlined below.

Removing Tags With Revisions

Place cursor between <SUB></SUB> Tags, right-click and choose Remove Tags

- OR -

Use the keyboard shortcut key Ctrl + M.

Removing Tags Without Revisions

Place cursor on the left side of the <SUB> Tag and press the delete key.

Our engineer gave me a Submittal Item to add to a Section, but he said it belongs under SD-19. Is this possible?

No. Since the agencies adopted the Unified Submittal Descriptions, only the eleven listed earlier in this chapter and the 01 33 00 Submittal Procedures Section may be used. The SpecsIntact Web site’s Knowledge Base (http://si.ksc.nasa.gov/uic/techhelp.htm) contains a conversion chart for the older numbers.
Post Editing Tips

Now that you’ve made all the text changes, it’s time to move on to the automated processes that make SpecsIntact unique.

But before you do, there are a few things you need to check.

After editing a Section, check the formatting by hiding all the on-screen elements that won’t appear in the printed document — tags, Revisions, notes, formatting marks, and which ever unit of measure you’re not using for the Job.

With all these hidden, visually check the formatting of the Section. There should be one blank line between paragraphs.

Before making any changes to adjust the formatting, don’t forget to turn the tags back on to avoid inadvertently deleting any of them.

“I have a table that is in Microsoft Excel® that needs to be added to my Section, can this be done?”

Amanda in Albany

As a matter of fact Amanda, it can be! First, you must prepare your Section by adding a Formatted Table that matches the number of rows and columns as the Excel worksheet. Once the Table has been added, right-click and choose Import Excel XML Spreadsheet. From the Specify File Name Dialog Box, browse to the Excel XML Spreadsheet then select Open.

Keep in mind, that it is important to understand the formatting of the Excel spreadsheet since it determines how well the Table imports into your Section. We highly recommend taking the time to review the Table information located in the SpecsIntact Help Files. To learn more about Importing Tables, see the following topic:

http://si.ksc.nasa.gov/WebHelp/SIEditor/hid_ediImportExcel.htm

Chapter 4
Post Editing Tips

When you’re finished editing, don’t forget to use the Spell Check feature. You can access this function from the Editor’s Tools menu.

In Chapter 6, you will learn how to Backup your Job. It is a good habit to use this tool at the end of each day when you have finished your editing.

So remember….Backup, Backup, Backup!

What you learned from this chapter:

♦ To edit a Section of your Job in the SI Editor, you always open it from the SI Explorer.
♦ The SI Editor’s toolbar allows you to control which elements are visible on your screen, and check the formatting by hiding the non-printing elements.
♦ The SI Editor’s Tags Bar provides buttons for easily inserting tags, which should never be typed manually.
♦ SpecsIntact’s advanced Revisions feature allows information that’s being added or deleted to be marked before these changes are actually made permanent.
♦ Editing shortcuts can make editing quicker.
♦ You should use the Quality Assurance tools (covered in Chapter 5) periodically as you edit to spot mistakes and prevent repeating them throughout the Job.
♦ Adding and deleting References and Submittals have special rules for each that, when followed, enable some of SpecsIntact’s automated features to work correctly.
♦ When you’ve finished editing, always run a spell check and visually check your formatting with non-printing elements hidden.
As mentioned earlier, one of the things that sets SpecsIntact apart from word processing programs are the automated features that help assure the quality of your finished specifications. The QA tools can help you find problems so that you can correct them before you commit your Job to paper. As we mentioned in Chapter 4, it is highly recommended that you use the Reconciliation feature and Reports periodically as you edit the Sections of your Job so that you’re not faced with editing errors you’ve repeated throughout the Job. Regardless, you should run these Reports again at least twice before printing — once to find any final errors, and again to confirm that you’ve fixed those errors.

The Process and Print/Publish function provides one-stop shopping for all the tools you need to take you to the finish line. So let’s take a look at the tools in this multi-function tool kit!

In this chapter you’ll learn:
♦ To use the Quality Assurance tools.
♦ What happens when you use the Process feature.
♦ How to locate and correct the problems found on the Reports.
Since the **Process & Print/Publish** command has multiple functions, you will need to become familiar with it as you work on your Job, and especially as you finish your text editing.

You access it from the **SI Explorer**:

*Click your Job folder in the left pane and use one of the following to open the **Process & Print/Publish** dialog box:*

  — **Click** the **File** menu and choose **Process & Print/Publish**.
  OR
  — **Click** the **Print** button on the Toolbar
  OR
  — **Right-click** the Job folder and choose **Process & Print/Publish** from the pop-up menu.

The Print Processing dialog box has seven tabbed screens.

If your Job doesn’t contain a cover page, you **will not** see the **Other Documents** tab.

If you don’t have **Adobe Acrobat**, you **will not** see the **PDF/Publish** tab, and you must have Microsoft Word installed for the **Word Publish** tab to be visible.
To make the correct choices in the Print Processing dialog box, it is important to understand the relationship between Reconciliation and Verification — think of active versus passive.

- **Verification Reports** are passive in that they only provide information — reporting errors and discrepancies that are found. Verification doesn’t do anything about the problems — you have to fix the errors and resolve the discrepancies.

- **Reconciliation** is active because it actually does something — it checks and compares, and then makes changes based on those findings.

These two work hand in hand, so it is important to select Reconciliation to achieve the correct results on the Verification Reports.

The three types of Reconciliation — Reference, Address, and Submittal — are all slightly different, and produce different results. But what they all have in common is that their goal is to eliminate the listing of elements that are not used in the text of your Job.

Briefly, here are the changes that the three Reconciliation functions make. Keep in mind these changes appear in the output versions of the Sections, not in the original .sec files.

- **Reference Reconciliation** only makes changes within the Reference Article of each Section so that it lists only those References that are actually cited in that Section’s text.

- **Address Reconciliation** should be used in conjunction with Reference Reconciliation. It only changes the 01 42 00 Sources for Reference Publications Section, making it unique to the Job by listing only the Sponsoring Organizations of References actually cited throughout the Job.

- **Submittal Reconciliation** only changes the 01 33 00 Submittal Procedures Section, making it unique to the Job by listing only the Submittal Descriptions actually used throughout the Job.
The first thing to remember when using the Reports function is that to get accurate results, you must process the entire Job as well as using the Reconciliation functions. Here are the default selections on the Sections and Reports tabs:

**Sections Tab**
- All Sections
- Print/Process Sections
- Renumber Paragraphs
- Addresses, References, and Submittals

**Reports Tab**
- Address Verification, Reference Verification
- Submittal Verification, Bracket Verification, and Section Verification

After you’ve made these selections, click the Process Only button to create the electronic files for your Reports (.rpt) and processed Sections (.prn).

If you select Process and Print, it will send your entire Job and the Reports to your printer in addition to creating the electronic files.
Quality Control Tools

Viewing & Printing Reports

The Report results can be found in the Processed Files folder under your Job in the SI Explorer's left pane, with the contents of the folder displayed in the right pane with an .RPT file extension.

You can print any of these reports from the SI Explorer by selecting the ones you want from the right pane and clicking Print/Publish.

The Report files (.rpt) can be opened in the SI Editor just like Section files. When you open a Report, you'll either see that there were no problems or there will be a list of problems found. The listed problems are hyperlinked to the Sections where they appear — just double-click and the Section will open with the cursor placed at the location of the problem.

Will it affect the results I see on the Reports if I don’t check the boxes to perform Reconciliation?

Yes, Reconciliation does effect the Report results. That’s why the Reconciliation boxes need to be checked any time you produce the Verification Reports — and all Sections in the Job selected for processing — otherwise, you’ll see reported errors that would be taken care of automatically using the Reconciliation process.

Keep in mind that the changes resulting from Reconciliation are only seen in the output files (prn, pdf or doc) — your .sec files remain unchanged.
Viewing Report Results

So now that you’ve produced the Reports, what do they show you?

In Chapter 6, we’ll show you in more detail how to use the various types of Report results you may encounter. For now, it’s important to learn how the QA process works.

Here’s a sample of the kind of results you might see on a **Section Verification** Report. The top portion explains the type of problem, followed by the list and locations. These are hyperlinked to the Section so that all you have to do is **double-click** and the Section will open in the Editor, and locate the cursor at the Subpart with the problem.

In this example, you would need to show the list to your engineer to determine how to resolve these issues — by either adding the missing Sections that are being referenced, or by eliminating the references to them.

---

**SECTION VERIFICATION REPORT**

This report lists all Sections that are referenced in other Sections, but that are not in the Job or Master.

**HINT:** Double-clicking a Section number will open the Section in the Editor.

<table>
<thead>
<tr>
<th>SECTION</th>
<th>SUBPART</th>
<th>SECTION REFERENCED</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>23 09 53.00 20</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>23 09 23.13 20</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>23 05 93</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>23 08 01.00 20</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>26 12 19.10</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>26 12 19.20</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>33 71 01</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>26 11 16</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>26 11 13.00 20</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.5.8</td>
<td>01 78 23</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.9</td>
<td>01 45 00.10 10</td>
</tr>
<tr>
<td>01 57 19.02</td>
<td>3.3.2.3</td>
<td>32 92 13</td>
</tr>
<tr>
<td>01 57 19.02</td>
<td>3.4</td>
<td>00 73 01</td>
</tr>
<tr>
<td>05 21 13</td>
<td>2.3</td>
<td>09 90 00</td>
</tr>
</tbody>
</table>
Here’s another example. This report shows that some of the bracketed choices have not been selected. In this case, you would locate the error, check your marked-up printed copy to determine whether your engineer had marked a selection or entered information. Each set of brackets in the Sections needs to be replaced with text and the brackets themselves removed before the Job is complete.

<table>
<thead>
<tr>
<th>SECTION</th>
<th>SUBPART</th>
<th>BRACKETS</th>
<th>EXPLANATORY NOTES</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 33 00</td>
<td>1.2</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.3.1</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.3.2</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.3.3</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.1</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.3</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.5.1</td>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>

BRACKET VERIFICATION REPORT

This report lists all brackets remaining in the text.

HINT: Double-clicking a Section number will open the Section in the Editor.

Always check first to see if a problem is simply the result of a typo.
When no problems are found — your goal before the Job is complete — the Reports will indicate that no errors or discrepancies remain.

Keep in mind that in the case of both **Submittals** and **References**, the listing must be identical — including spaces — in the text, the corresponding Submittal or Reference Article in the Section, as well as in the **01 33 00 Submittal Procedures Section** or the **01 42 00 Sources for Reference Publications Sections**. Otherwise, they will appear on the Reports as discrepancies.

One major difference is that **References** are **case sensitive**, while Submittals are not.

Chapter 6 has details on fixing the different types of errors and discrepancies you may encounter on the Reports.
Other QA Tools

Submittal Register and Lists

In addition to the Verification Reports, you can also produce several lists and the Submittal Register from the Reports tab in the Print Processing dialog box.

Reports Tab

- **Reference Location List**
  Itemizes all the References cited in the text, followed by the Section and Subpart locations where they are found.

- **Submittal List**
  Itemizes all the Submittal Descriptions found in the Sections’ Submittal Articles, along with the Section and Subpart locations in which they are found.

- **Submittal Register**
  Lists the materials, products or items for each Submittal, as well as the Section and Subpart locations in which they are found.

- **Test Requirements List**
  Itemizes all the test requirements cited and includes the Section and Subpart locations in which they are found.

After you’ve made these selections, click the **Process Only** button to create the electronic files for your Reports (.rpt) and processed Sections (.prn).

If you select **Process and Print**, it will send your entire Job and the Reports to your printer in addition to creating the electronic files.

The Submittal Register can only be viewed as a Portable Document File (PDF) or on hard copy.
You’ve arrived! You’ve now reached the point where you want to produce your Job’s edited Sections in their final format — all the changes, no tags, perfect!

Once again, you’ll use the Process and Print/Publish command on the SI Explorer’s File menu or the corresponding button on the toolbar. This time, you’ll make different selections than you did when you accessed this box to produce the Reports. It’s important to understand how to make the right choices so you can achieve the exact results you want.

As we mentioned before, the .sec files are your editing copies of the Sections — they are used to produce your final copy. We’ve discussed the processing that occurred as you used the QA tools from the Process & Print/Publish function. But instead of using the Process Only button as you did before, you’ll now use the Process & Print button.

But before you click that button, you want to make certain that the settings on all the tabs are correct to produce the Job the way you want. In addition, you may have been asked to deliver the electronic files in Word or PDF instead of SpecsIntact’s .prn files — the two additional output formats that can be produced through SpecsIntact, as long as you have the corresponding software.

So let’s take another look at the multi-function Print & Process/Publish dialog box.

By this time, you should be familiar with the first two tabs of the Process & Print/Publish box, but you’ll now learn how to use their settings to produce your Job. In addition, you’ll see how the settings on the Other Documents, Options and Header/Footer tabs are used to determine what your output files contain. And finally, you’ll learn about the settings you’ll use if you choose to Publish your Job in either PDF or Word.
Sections & Reports Screens

On the next few pages, we'll show you the settings and choices you should make to produce your final, processed and printed Job.

Sections Tab

- All Sections
- Print/Process Sections
- Renumber Paragraphs
- Reconcile Addresses, References, Submittals
- Choose Printer from drop-down list (If you plan to produce the output files in Word you can skip this step.)

If you want to save some but not all the settings made on the various screens of this dialog box, make the ones you want to save first, click the Save Settings button, then make the additional selections that you want to use for just this printing.

Reports Tab

- Submittal Register, if required
- Any of the Lists requested by your project engineer
- All Verification Reports (Run again to double check that all issues have been resolved.)
- Make Project and Section Table of Contents selections based on requirements (Scope is a brief description).
Process & Print/Publish Settings

Other Documents & Options Screens

Other Documents Tab

- If you created a **Cover Page** to include, in either .sec or .rtf format, you will see this tab. If you do not have a Cover Page, this tab is not visible. Check to include the cover with the Job. Covers can be added using the SI Explorer’s File menu | Properties | General tab.

Options Tab

- **Section Dates** (if required)
- **Color** (when using a color printer) - Setting also controls PDF output.
- **Units of Measure** choose **English**, **Metric** or **Both**.
- The starting **Page Numbering** can be changed.
- Select whether you want each Section to start over with its own numbering.
- **Print Range** **All Pages**.
- **Table Borders** can be controlled by the Section File or by changing the selection to **Use No Borders** or **Use Thin Borders for all Tables**.
- The sliding **Font Size** bar provides better control of the Fonts within Formatted Tables that may result from printer drivers.
QuickStart Guide

Chapter 5

Process & Print/Publish Settings

Header/Footer Screen

Header/Footer Tab

- Make any changes to Headers or Footers (see tips below). The defaults reflect the standard requirements for printing a Job.

Pipe (|) symbols control the horizontal position of the text in the header and footer lines. The pipe symbols are inserted by using the Shift and \ (backslash) key. Here are the formatting rules:

- To center, place text between two pipes: |this text will be centered|
- To align left, use no pipes: this text will align left
- To align right, place two pipes to the right of the text: ||this text will align right
- To align both right and left, place two pipes dividing the text: this text will align left||this text will align right
- To center and align both right and left, use pipes to divide: this text will align left|this text will center|this text will align right

When setting headers and footers, here are two tips to help you with formatting:

- The vertical position can be changed by entering a different number in the Start at Line Number box (header default is 4; footer default is 62).
- Change the first line or add a second line for either header or footer by using the Variables box.

So just what is a Variable?

Think of it as a place holder. It represents the information that will be placed on each page in the location indicated.
Creating **PDF** or **Word** files is called **Publishing** since it produces electronic files that can later be printed on paper through the SI Explorer. Once published, they can be found in PDF and Word folders under the Job in the Explorer’s left pane.

**PDF Publish Tab**

- If **PDF** output files are required, select the desired settings. The electronic files produced will be visible in the left pane of the SI Explorer under the Job in a **PDF Files** folder. Your **Adobe Acrobat** software should be chosen from the Printer drop-down box (names will vary by Adobe version).

Using the **PDF Publish** feature to **Combine Processed Files Into One document** is a good idea.

1. From the **Print Processing** dialog box, select the **Reports** tab.
2. Under the **Project Table of Contents** section, select **Include without Scope**.
3. Under the **Section Table of Contents** section, select **Include without Scope**.
4. On the **PDF Publish** tab, select **Bookmarks** and choose one or both options below:
   - Add Section number to Section bookmark
   - Add Section Number to Section table of contents bookmark
5. **Select Combine Processed Files Into One Document** (publish.pdf).
6. **Choose Include Project Table of Contents in Combined PDF Document**.
7. **Select Process & Publish**.
Word Publish Tab

- If **Word** output files are required, select the desired settings. The electronic files produced will be visible in the left pane of the SI Explorer under the Job in a **Word Files** folder. When Word is selected for output, the Printer box is no longer visible.

Only Section files can be published in Word, not the Tables of Contents or Reports.

After you've made all your selections, click the **Process and Publish** button. If your choice of output format is **PDF** or **Word**, then the button will say **Process and Publish**, indicating that the files produced will be electronic and not printed on paper.
Printing PDF and Word Output Files

If you use the **Publish** function to produce either **PDF** or **Word** electronic files, you may want to print a hard copy. You can do this from the **SI Explorer** — either for all the Sections that you have in the output folder or for selected Sections.

1. **Click** the output folder in the left pane (**PDF Files** or **Word Files**) to display its contents in the right pane.
2. **Click** anywhere in the right pane, then **click** the **Sections** menu and choose the **Select All** command. You can also choose only selected Sections from the right pane if you don’t want to print them all.
3. **Click** the **Print** button to send the files to your default printer.

You can also print the **Processed Files** (.prn) in the same way.

If you find additional changes you need to make, you can rerun the **Process & Print** function again — just keep in mind that the previous output files — processed Sections (.prn), PDF (.pdf), and Word (.doc) — will be replaced by the new ones (the exception is if you chose the option to retain previous files on the PDF screen).

If you edit your Word output files, these changes will not be reflected in your source .sec files, so if you subsequently generate new Word output files, your changes will be lost.
“Help! I changed my headers and footers, but when I went back to Print & Process again, the changes were gone! What happened? Do I have to reset the headers and footers every time I process?”

Karen in Kansas City

No, you just needed to save those settings to make them your new defaults. If you open the Process & Print/Publish dialog box and go to the Header/Footer tab, you can make any changes you want, and then click the Save Settings button on the right. Keep in mind that doing this will also save any other changes you’ve made since you opened the dialog box, and they will become the new defaults. It’s a good idea to make changes you want to keep first, click the Save Settings button, and then continue to make one-time changes you don’t want to save as your defaults.

By now, you have been through all the major features of SpecsIntact that you need to use to produce your Job successfully.

As with all software, there are many factors that can affect how you need to adapt as you work. In Chapter 6, we’ll give you some additional tips and cover just a few of the extra features found in SpecsIntact that can help you use it to its full potential and yours!
What you learned from this chapter:

♦ There are a variety of Quality Assurance tools to assist you by checking the various elements of your Job. They are accessed through the Process & Print/Publish function.

♦ Reconciliation actually makes changes within the Job, while Verification only locates errors and discrepancies that need to be resolved and displays them on Reports.

♦ By viewing the results of the Reports, you identify the errors and discrepancies found, and hyperlink to their locations so that you can resolve them by first checking for typos, then consulting with your engineer if the issue involves technical content.

♦ Reports should be rerun until all problems have been eliminated.

♦ Additional lists and the Submittal Register can also be produced through the Process & Print/Publish function.

♦ SpecsIntact has a Backup feature that lets you make an archive copy of your entire Job.

♦ If you are require to use Revisions, you need to execute them prior to the final processing of your Job. It’s recommended that you backup your Job before executing Revisions, since those changes will become permanent.

♦ After all the Reports are clean, you use the Process & Print/Publish function to produce your Job in the desired output format.

As always, if you have questions or encounter problems, we provide live tech support Monday - Friday, 12:00 p.m. - 4:30 p.m. (ET).

The support email is KSC-SpecsIntact@nasa.gov. You can reach them by phone at 321-867-8800, or fax at 321-867-1444.
In this chapter you'll learn:

♦ How to use other handy tools that come with SpecsIntact.
♦ Tips, shortcuts and editing techniques to make your work easier.
♦ Proper use of symbols and capitalization.
♦ How to fix errors and discrepancies that appear on QA Reports.
♦ What information the Lists can provide.
♦ How to restore a Job from an archived backup copy.
♦ How to use a checklist to make sure you’re ready to deliver the final Job.

In this chapter, we'll present some additional tips and tools that may help you more effectively produce a finished Job. As we said in the introduction, this QuickStart Guide is not intended to cover every aspect of using the software. You should use it in conjunction with the other user tools provided with SpecsIntact and on our web site.

Some of the pages in this chapter are designed to be printed as quick reference charts that you can keep at your desk as you work. There are also pages dedicated to helping you fix the errors and discrepancies found on each of the QA Reports.

As you continue to work in SpecsIntact, you'll find which methods work best for you. As with most software, there are several ways to access functions and perform tasks. With a little experience, you'll discover how to streamline your work process.
In addition to the features we’ve covered in the previous chapters, SpecsIntact has some other handy tools you can choose to use along the way.

**More SI Tools**

**Keeping Track**

Here are tools you might find useful in tracking some of the information about your Job:

- The **Job Properties** box — accessed from **File** menu | **Properties** or toolbar button — has four additional tabs for tracking information. The **Schedule** screen lets you keep track of review status, dates and hours expended. The **Specifiers** screen lets you assign different engineers to specific Divisions. The **Options** screen lets you choose the Units of Measure, Use Revisions (default setting), the MasterFormat Version and now lets you choose the Automatic Paragraph Numbering, Numeric or Alphanumeric. The **Comments** screen allows free-form entry that adds an automatic date/time stamp to each. The Properties box also has a **Print** button in the lower left so that you can produce a printed copy of this information.

- You can use **Setup** | **Options** | **Specifiers** tab to make a reusable list of Specifiers that will be available from the drop-down boxes on the **Specifiers** screen mentioned above.

**Customizing Your View**

Here are a few changes you can make to adapt what you see on your screen in the **SI Explorer**:

- **Column Headers** — by using the **View** menu, you can change the information that appears in the right pane of the **SI Explorer** by either adding or removing Column Headers. (See caution below)
- **Setup menu | Options | General tab** — allows you to adjust settings that control various functions, as well as resetting some defaults.
- **Colors** — You can change the color of the Job, Master and file icons by **right-clicking** on them and choosing the icon color option from the right-click menu.

Choosing to display some of the column headers — particularly the **Section Date** and **Preparing Activity** — may slow down the speed with which the Sections display in the SI Explorer. This is especially true with large Masters or if there’s a large number of Jobs.
More SI Tools

Emailing Files
It’s always a good idea to make a backup of your Job files daily, and it’s a good way to archive a finished Job. This same function also provides a method for emailing your entire Job in the .zip file format. The Backup/Restore/Manage box can be accessed from the SI Explorer’s File menu. You must first make the backup copy of the Job, then select it for emailing.

Due to file blocking at NASA, the Technical Support Staff cannot receive .zip files. If you need to send a Job to SI Tech Support for problem resolution, contact them at (321) 867-8800 for instruction.

To email Section files, select them in the SI Explorer’s right pane and choose the Sections menu | Email command. With this function, they are sent uncompressed in the .sec format.

Templates
You’ll see two different types of templates used in SpecsIntact. You can access both from the SI Explorer’s Tools menu.

- **Section Templates** — Outlines used as guidelines for creating new Sections. The option to create Section templates on the Tools Menu should be used to create unique Section outlines, not new Sections. New Sections can be created from Add Sections dialog box.

- **SI Document Templates** — Blank document which may be used to create a cover sheet, project information sheet, sign-off sheet, or other unique documents to be used with specifications.

Chapter 6 QuickStart Guide 84
SI Explorer Help Menu
From the Help menu you can access the following:

- **On-Screen Help** — Features an Explorer view that displays topics in the right pane and a table of contents in the left pane, as well as offering search capabilities.
- **SI Web Site** — Link directly to the SpecsIntact web site resources to download software and Masters, view the Knowledge Base, and keep up on new developments regarding the software.
- **SI Web Help Center** — Link directly to the SpecsIntact web site for resources to assist both novice and proficient users. Here you can discover the Installation Guide, QuickStart Guides, QuickTours, Knowledge Base, Online Help and Support.
- **About SpecsIntact** — Allows you to check the SI version number you are using, and documents where SpecsIntact is installed on your system (both important when contacting tech support for assistance).

SI Editor Format Menu
Formatting commands you can access from the Editor’s Format menu are:
- Font
- Margins
- Change Case
- Toggle Indentation
- Indentation Amount

You should use Font and Margins changes with caution since these are global settings that will affect every Job and Master you have as well as the Reports. Check the Help topics for these commands to learn more before deciding whether to make changes to the defaults.

Don’t forget that you can customize the Editor’s Tags Bar to display only the tag buttons you use frequently. Use the down arrow button at the right end of the Tags Bar to add or remove buttons from the display.

Remember that the right-click menus change depending on the actions available in any given situation. If there is something you are trying to do, and you don’t know how to perform the action, try right-clicking to see if there is a menu option for it.
SI Tips

SI Tag Character Limitations
Certain tags within SpecsIntact have character limitations you should be aware of.

- **Section Title**
  - 120 Characters

- **Section Number**
  - 6 Characters
  - (MasterFormat 1995)
  - 14 Characters
  - (MasterFormat 2010)

- **Date**
  - 5 Characters

- **Article Titles**
  - 71 Characters

- **Paragraph Titles**
  - 68 Characters

- **Reference Organization**
  - 511 Characters

- **Reference Identifier**
  - 30 Characters

- **Reference Title**
  - 300 Characters

- **Section Reference**
  - 6 Characters
  - (MasterFormat 1995)
  - 14 Characters
  - (MasterFormat 2010)

Table Tips

- For additional flexibility, Tables may be placed within Text `<TXT>`, List `<LST>`, and Item `<ITM>` tags to allow more control of table positioning.
- Formatting tags that you can use inside a table are those for underline, italics and bold.
- Use the Table Menu to Justify (Left, Center, Right) the text rather than using tags, this will make table editing less complicated.
- Apply additional tagging for References and Submittals, etc. after all the information has been entered into the table.
- A table can be located inside a Note. Do not place `<NPR>` tags around a table within a Note.
- When using measurements in a table, the preferred method is to duplicate the formatting and make a separate table for each measurement (English and Metric). Check for formatting by turning off the tags for each type of measurement separately to ensure clean formatting for both.
- When using Revisions to markup a table consider duplicating the table first, edit the added Table then completely delete the existing table so it will be surrounded by the `<DEL>` tags.
Shortcuts

SI Explorer Keyboard Shortcuts

Ctrl + Key
New Job Ctrl + J
New Master Ctrl + M
Add Sections Ctrl + A
Process & Print Ctrl + P
Edit Ctrl + E
Search & Replace Ctrl + F

Function Keys
Screen Refresh F5
Options F2
Help F1
Delete Delete key

SI Editor Keyboard Shortcuts

Deleting Tagged Elements Shift + Delete

SI Editor Keyboard Shortcuts

Ctrl + Key
Delete Ctrl + D
Copy Ctrl + C
Copy without Tags Ctrl + E
Find Ctrl + F
Replace Ctrl + H
Find Tags Ctrl + I
Remove Tags Ctrl + M
Toggle Indentation Ctrl + N
Open Ctrl + O
Print Draft Ctrl + P
Save Ctrl + S
Paste Ctrl + V
Cut Ctrl + X
Redo Ctrl + Y
Undo Ctrl + Z
Page Break Ctrl + Enter

Function Keys
Help F1
Next F3
Insert Tags F4
Spell Check F7

Shift + Function Keys
Revisions On/Off Shift + F8

To toggle the following screen elements on or off:

Alt + Key
Tags Alt + S
Notes Alt + N
Revisions Alt + R
English Units Alt + G
Metric Units Alt + M
Both English/Metric Alt + B
Marks Alt + A
Editing Techniques

Selecting and Deleting

On the next few pages, you will discover various techniques that can be used to select tagged elements and text. Combining these techniques will help you become a proficient editor. So let’s get started!

Keystrokes for Selecting Text

- **Shift + Right** or **Left arrow** — selects one character at a time.
- **Shift + Ctrl + Right** or **Left arrow** — selects one word at a time.
- **Shift + End** — selects from cursor to end of a line.
- **Shift + Home** — selects from cursor to beginning of a line.
- **Shift + Down** or **Up arrow** — selects one line at a time in the applicable direction.
- **Shift + PgDn** or **PgUp** — selects a page at a time in the applicable direction.
- **Shift + Ctrl + Home** — selects from cursor to the beginning of the Section.
- **Shift + Ctrl + End** — selects from cursor to the end of the Section.

You can delete tagged text using the **Shift** and **Delete** keys.

The Shift and Delete key combination can be used to delete an entire tagged element (including any other tagged elements nested within the selected tags). To use this function, the Editor must be in the **View Tags** mode. Position the cursor immediately to the left of the beginning tag of the element you want to delete, **hold** the **Shift** key and **press** the **Delete** key. The beginning and ending tags will be deleted, along with everything in between. Although this shortcut can delete any tagged item, it is best used for deleting entire Subparts!

For example, to delete a Subpart:

```xml
</SPT =1.4.1><SPT =1.4.2>1.4.2 <ITL>Storage</ITL>

<ITX>Inspect materials delivered to the site for damage; unload and store out of weather in manufacturer's original packaging. Store only in dry locations, not subject to open flames or sparks, and easily accessible for inspection and handling.</ITX>

</SPT =1.4.2></SPT =1.4><SPT =1.5>1.5 <ITL>Safety Precautions</ITL>
```
Editing Techniques for Revisions

Double-click Method to Select Text

In this Section you will learn when to use the double-click method to remove text versus when to highlight to remove text. The double-click method is preferred when you need to remove an entire Subpart level but for all other instances you must learn how to highlight properly. This will show you how to avoid tagging issues and leaving hard returns and spaces throughout your document. So let’s get started! Keep in mind, these examples can also be used whether you are using Revisions or not, but is the preferred method for editing with Revisions!

In order to remove an entire Subpart, place the cursor on a word within the Subpart Title and Double-click.

Double-clicking again within the Title will expand the selected region to include the immediate surrounding text and pair of tags.
Editing Techniques for Revisions

Double-click Method to Select Text

Double-clicking one more time will expand the selected region to include entire subpart.

If needed, you can continue to use this method until you have multiple subparts selected or even the entire Part (but you cannot select an entire Section by this method). Now that you have learned to remove subparts, let’s move onto learning how to properly remove other areas throughout your specification.

While using Revisions, the most efficient way to remove key elements such as TXT, LST, and ITM tags, (including indents), is by using the mouse to highlight these areas. By learning to do this correctly you will avoid leaving unnecessary spaces between words and throughout the specification.

Once you become comfortable with the double-clicking method, you may want to try out the Shift and Delete shortcut for removing entire subparts!

The best way to remove only the Tag, not the text, without having to turn Revisions off is to use the keyboard shortcut Ctrl + M or place the cursor between the tags (<SUB></SUB>), right-click and choose Remove Tags.
Editing Techniques for Revisions

Highlight to Select Text

In this example, we will be removing the Submittal Item “Fabrication Drawings”.

Before:

<LST><SUB>SD-02 Shop Drawings</SUB></LST>

<ITM><SUB>Fabrication Drawings</SUB></ITM>

<ITM><SUB>Metal Floor Deck Units</SUB></ITM>

After:

<LST><SUB>SD-02 Shop Drawings</SUB></LST>

<DEL><ITM><SUB>Fabrication Drawings</SUB></ITM></DEL>

<ITM><SUB>Metal Floor Deck Units</SUB></ITM>

<ITM><SUB>Cant Strips</SUB></ITM>

Example with Tags & Revisions Hidden:

<LST><SUB>SD-02 Shop Drawings</SUB></LST>

<ITM><SUB>Metal Floor Deck Units</SUB></ITM>

No Extra Space Where Fabrication Drawings Was Deleted!
Editing Techniques for Revisions

Selecting Text

With this example, we will be removing the last TXT paragraph within a subpart. This highlighting technique will be the same regardless of the last element within the subpart.

*Before:*

```xml
</SPT =2.2.5><SPT =2.2.6>2.2.6  <TTL>Cover Plates</TTL>

<TXT>Sheet metal to close panel edge and end conditions, and where panels change direction or butt. Polyethylene-coated, self-adhesive, ENGD 2 inch/ENGD wide joint tape may be provided in lieu of cover plates on flat-surfaced decking butt joints.</TXT>

<TXT>Fabricate cover plates for abutting floor deck units from the specified structural-quality steel sheets not less than nominal thickness before galvanizing. Provide ENGD 6 inch/ENGD wide cover plates and form to match the contour of the floor deck units.</TXT>
```

*After:*

```xml
</SPT =2.2.5><SPT =2.2.6>2.2.6  <TTL>Cover Plates</TTL>

<TXT>Sheet metal to close panel edge and end conditions, and where panels change direction or butt. Polyethylene-coated, self-adhesive, 2 inch/ENGD wide joint tape may be provided in lieu of cover plates on flat-surfaced decking butt joints.</TXT>

<DEL>TXT>Fabricate cover plates for abutting floor deck units from the specified structural-quality steel sheets not less than nominal thickness before galvanizing. Provide ENGD 6 inch/ENGD wide cover plates and form to match the contour of the floor deck units.</DEL>
```

*Example with Tags & Revisions Hidden:*

```
2.2.6  Cover Plates

Sheet metal to close panel edge and end conditions, and where panels change direction or butt. Polyethylene-coated, self-adhesive, 2 inch wide joint tape may be provided in lieu of cover plates on flat-surfaced decking butt joints.

2.2.7  Roof Sump Pans
```
Fixing QA Report Errors and Discrepancies

Using the Reports to identify, find, and fix problems in your Job is key to producing final specifications that are accurate and complete. In the next few pages, we'll illustrate some of the errors and discrepancies you may find and tell you how to resolve them.

Don't forget, the keys to getting accurate Report results are:

- Make sure your Job contains both the 01 33 00 Submittal Procedures Section and the 01 42 00 Sources for Reference Publications Section.
- Process all Sections, not just some Sections
- Choose all three Reconcile (Address, Reference, and Submittals) checkboxes from the Print Processing Sections tab.

After processing, the Reports reside in your Job's Processed Files folder. Click this folder in the SI Explorer's left pane to display it's files in the right pane. The Reports will have a file extension .RPT and a red icon. Double-click to open a Report in the SI Editor.

Three helpful hints that apply to resolving problems on any of the Reports:

1. Always check first to see if the problem is the result of a typographical error.
2. Display the Marks to check spacing — each space will be represented by one dot on the screen. Show Marks using the command on the Editor’s View menu or the corresponding button on the toolbar.
3. Double-click any Section number within a Report to open that Section in the Editor. Your cursor will be placed at the Subpart containing the problem. Tags are automatically hidden when you use this hyperlinking from the Reports, but before making any changes, display the tags on your screen to ensure accuracy.
Fixing QA Report Errors and Discrepancies

Address Verification Report

The **Address Verification Report** *(ADDRVER.RPT)* lists **Reference Organizations** that appear in any Section’s **Reference Article** without a corresponding listing in either the **01 42 00 Sources for Reference Publications Section** or the **Supplemental Reference List (SRL)**.

Address Verification:

- **Verifies** that all **Sponsoring Organizations** with **References** cited in the processed Sections’ text appear in the Job’s **01 42 00** Section.
- **Generates** a list of **Sponsoring Organizations** used in any Section’s **Reference Article** but *not* found in the Job’s **01 42 00** Section.

**Example of Address Verification Results:**

<table>
<thead>
<tr>
<th>SECTION REFERENCE ORGANIZATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>06 20 00 DIESEL ENGINE MANUFACTURERS ASSOCIATION (DEMA)</td>
</tr>
</tbody>
</table>

**Resolving Discrepancies**

If the **01 42 00** Section of the Job *already lists* the Reference’s Sponsoring Organization:

1. **Add** the **Sponsoring Organization name**, **acronym**, **Reference Identifier** and **Reference Title** (with all corresponding **tags**) to the Section’s **Reference Article**.
2. **Verify** that the information that you added to the Section’s Reference Article is **identical** — including text, spaces, and capitalization — to the one found in the **01 42 00** Section.

If the **01 42 00** Section of the Job *doesn’t list* the Reference’s Sponsoring Organization:

1. **Add** the **Sponsoring Organization name**, **acronym**, **Reference Identifier** and **Reference Title** (with all corresponding **tags**) to the Section’s **Reference Article**.
2. **Right-click** on the **Reference Identifier** you just added, and choose **Check References** from the pop-up menu.
3. **Click Yes** when prompted to automatically add the Reference to your **Supplemental Reference List** (which will open so that you can confirm the addition).
4. **Open** your Job’s **01 42 00** Section and **add** the **Sponsoring Organization name**, **acronym**, **address**, **phone/fax numbers**, **email address** and **web address** (with all corresponding **tags**) making certain that text, spaces and capitalization are identical to the listing you added to the **Reference Article**.
Fixing QA Report Errors and Discrepancies

Reference Verification Report

The Reference Verification Report actually produces three separate listings: Duplicate References (DUPEREF.RPT), Reference Title Discrepancies (TTLDIFFS.RPT), and References Verification (REFVER.RPT).

Reference Verification:

- Compares the References in each Section’s text with those in its Reference Article and in the Supplemental Reference List (SRL).
- Identifies discrepancies by producing three separate reports that list duplicate References, conflicting Titles, and unresolved References.

Duplicate References

The DUPEREF.RPT lists of all the References that are found in the Reference Articles and duplicated in the Supplemental Reference List. The Reference Descriptions listed on the report are from the Supplemental Reference List.

Example of Duplicate Reference Results:

<table>
<thead>
<tr>
<th>SECTION REFERENCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>33 32 16.13  ANSI B16.11</td>
</tr>
<tr>
<td>AMERICAN NATIONAL STANDARDS INSTITUTE (ANSI)</td>
</tr>
<tr>
<td>ANSI B16.11 1980 Forged Steel Fittings, Socket-Welding and Threaded</td>
</tr>
<tr>
<td>02 41 00 ASTM C29</td>
</tr>
<tr>
<td>ASTM C29 1978 Unit Weight and Foids Aggregate</td>
</tr>
</tbody>
</table>

Resolving Duplicate

Check References in the Sections’ Reference Articles against those in the Supplemental Reference List (SRL).

- If the duplicates are identical in both locations (exactly the same text, spacing and capitalization) then remove the duplicate from the SRL.

If the duplicates have differences in the titles or dates, your engineer should review the publications to determine which is applicable to the Section:

- If the SRL contains the correct Reference, edit the Section’s Reference Article to correct it, then remove the duplicate from the SRL.
- If the Section’s Reference Article contains the correct Reference, remove the duplicate from the SRL.

After all corrections are made, run Reference Reconciliation again.
Fixing QA Report Errors and Discrepancies

Reference Title Discrepancies

The TTLDIFFS.RPT lists Reference Identifiers with conflicting Reference Titles in two or more Section Reference Articles.

Example of Reference Title Discrepancies Results:

<table>
<thead>
<tr>
<th>SECTION</th>
<th>REFERENCE</th>
<th>REFERENCE TITLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>26 20 00</td>
<td>NEMA TC 2</td>
<td>(1983) Electrical Plastic Tubing (EPT) and Conduit</td>
</tr>
<tr>
<td>26 27 29</td>
<td>NEMA TC 2</td>
<td>(1983) Electrical Plastic Tubing (EPT) and Conduit (EPC-40 and EPC-80)</td>
</tr>
</tbody>
</table>

Resolving Reference Title Discrepancies

- **Compare Titles** and determine which is correct for the publication. If publication dates differ, the engineer should review the publication to determine which applies to the Section.
- **Edit** the listed Sections’ Reference Articles so that they all reflect the correct Title and date for the publication.

Unresolved References

The REFVER.RPT lists References that appear in any Section’s text but not in either the Section’s Reference Article or the Supplemental Reference List.

Example of Unresolved References

<table>
<thead>
<tr>
<th>SECTION</th>
<th>SUBPART</th>
<th>REFERENCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>33 11 00</td>
<td>2.1.1.1</td>
<td>AWWA C110/A21.10</td>
</tr>
</tbody>
</table>

Correcting Unresolved References

- **Add** the Reference and Reference Title (which includes the Publication date) to either the Section’s Reference Article or Supplemental Reference (SRL).
- If you made your changes in the SRL, then **run Reference Reconciliation** again to automatically insert them in the Reference Articles.
The Submittal Verification Report (SUBMVER.RPT) is used to report problems that result from the improper use of Submittals. This report is divided into two sections, the first section of this report lists Sections that do not cite Submittal Items in both the Submittal Article and elsewhere in the text, that cite invalid Classifications, or that contain Submittal Descriptions or Classifications outside the Submittal Article.

The second section of the report lists Submittal Descriptions in the Submittal Procedures Section 01 33 00, or that are missing from it.

Submittal Verification:

- **Checks** that all Submittal Items appear both in the Sections’ Submittal Article and also in the Sections’ text.

- Generates a list of Submittal Items missing from either location. See Example A.

- **Checks** that all Submittal Descriptions used in the Sections’ Submittal Articles are also listed in the Job’s 01 33 00 Section.

- Generates a list of Submittal Descriptions missing from the 01 33 00 Section. See Example B.

Example A of Submittal Verification Results:

<table>
<thead>
<tr>
<th>SECTION</th>
<th>SUBPART</th>
<th>SUBMITTAL DISCREPANCY</th>
</tr>
</thead>
<tbody>
<tr>
<td>05 12 00</td>
<td>2.1</td>
<td>SHOP PRIMER was not found in the Submittal Article.</td>
</tr>
<tr>
<td>05 12 00</td>
<td>1.3</td>
<td>Class B coating was not found outside the Submittal Article.</td>
</tr>
</tbody>
</table>
Fixing QA Report Errors and Discrepancies

Correcting Submittal Verification Discrepancies

• If a **Submittal Item** appears under an **SD** number within the **Submittal Article** but nowhere in the **Section** text, either **add** the **Submittal Item** at the appropriate point in the text, or **delete** it from the **Submittal Article**.

• If a **Submittal Item** is located within the text but **not in the Submittal Article**, consult your engineer to determine which one of the following methods of correction is appropriate:
  - **Insert** it in the **Submittal Article** below the correct **SD number**.
  - **Remove** the `<SUB>` tag surrounding the **Item** within the text.
  - **Delete** both the **Item** and `<SUB>` tag from the text.

• Submittal Descriptions (SDs) and Classifications (G for Government Approved) can only appear in the Submittal Article. Any citations of these in the text (outside the Submittal Article) must be deleted.

---

**Example B of Submittal Verification Results:**

<table>
<thead>
<tr>
<th>STANDARD DESCRIPTION</th>
<th>SECTION</th>
<th>SUBPART</th>
<th>INVALID DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SD-03 Product Data</strong></td>
<td>03 30 00</td>
<td>1.3</td>
<td><strong>SD-03 Product Materials</strong></td>
</tr>
</tbody>
</table>

---

Correcting Submittal Verification Discrepancies

**Submittal Description (SD) Numbers** used in the Job must be listed in the Job’s **01 33 00 Section**.

• If the **SD Number** reported is a **valid** Submittal that is **not found** in **Section 01 33 00**, then **add** it to the **01 33 00**.

• If the **SD Number** reported is **invalid**, it must be **changed** to one of the eleven valid numbers cited in the **01 33 00 Section**, or **omitted** from the Section.
Fixing QA Report Errors and Discrepancies

Bracket Verification and Section Verification Reports

The Bracket Verification Report (BRKTER.RPT) lists all brackets remaining in the Sections that must be removed and replaced with text before a Job is complete.

Example of Bracket Verification Results:

<table>
<thead>
<tr>
<th>SECTION</th>
<th>SUBPART</th>
<th>BRACKETS</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 33 00</td>
<td>1.2</td>
<td>10</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.3.1</td>
<td>2</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.3.2</td>
<td>2</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.3.3</td>
<td>4</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1</td>
<td>10</td>
</tr>
</tbody>
</table>

Resolving Bracket Verification Problems

- If a bracket was inadvertently left in the text, delete the bracket.
- If Bracketed Options were left in the text, a selection must be made or information filled in and the brackets deleted. Consult your engineer to determine the correct option to include.

The Section Verification Report (SECTVER.RPT) lists any Sections that are referenced in other Sections of the Job, but that are not part of the Job.

Example of Section Verification

<table>
<thead>
<tr>
<th>SECTION</th>
<th>SUBPART</th>
<th>SECTION REFERENCED</th>
</tr>
</thead>
<tbody>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>23 09 53.00 20</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>23 09 23.13 20</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>23 05 93</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>23 08 01.00 20</td>
</tr>
<tr>
<td>01 33 00</td>
<td>1.4.1.2</td>
<td>26 12 19.10</td>
</tr>
</tbody>
</table>

Section Verification:

- Checks to see that all Sections cited in the text are included in the Job.
- Generates a list of any Sections referenced that are not included in the Job.

Resolving Section Verification Discrepancies

Check with your engineer to determine if you should:

- Add the referenced Sections to the Job.
- Remove the text that references the missing Section.

Section Reference Tags should only contain the Section Number.

<SRF>09 90 00</SRF>
The **Reference List** *(REFKYLST.RPT)* includes all the **References** cited in the Job, followed by the **Sections** and **Subpart Numbers** where they can be found.

![Reference List Example](image1)

The **Submittal List** *(SUBMLIST.RPT)* includes all the **Submittal Descriptions** found in the **Submittal Articles**, along with the **Sections** and **Subparts** in which they can be found. The SD definitions are extracted from the **01 33 00** Section.

![Submittal List Example](image2)

The **Test / Requirements List** *(TSTRQLST.RPT)* includes all the **Test Requirements** cited in the text, along with the **Sections** and **Subparts** in which they can be found.

![Test Requirements List Example](image3)
The Submittal Register

The Submittal Register lists the materials, products or items for each Submittal cited in the Job, as well as the Section and paragraph number locations, and any required approval.

When the Submittal Register is generated, the system:

- **Searches** for the Submittal Article within PART 1 of each Section.
- **Locates** all tagged Submittal Descriptions (SDs) listed in each Section’s Submittal Article.
- **Locates** the Submittal Items appearing below the SDs and throughout the Sections.
- **Generates** the Submittal Register and inserts the Subpart location for each Submittal Item in the Sections’ text (outside the Submittal Articles).

### Troubleshooting the Submittal Register

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column (f)</strong> Classification Government or A/E Reviewer has double G G</td>
<td>The Submittal Item is listed twice in the Submittal Article under the same Submittal Description.</td>
</tr>
<tr>
<td><strong>Column (e)</strong> Paragraph # is blank</td>
<td>The Submittal Item is only found in the Submittal Article and is not used anywhere in the Section’s text.</td>
</tr>
<tr>
<td>A/E appears in Column (d) instead of Column (f).</td>
<td>Classification G must precede Reviewer as follows: <code>&lt;SUB&gt;G A/E&lt;/SUB&gt;</code></td>
</tr>
<tr>
<td>FIO appears in Column (d) instead of Column (f).</td>
<td>FIO is no longer recognized on the UFGS Submittal Register and should not be used in the Submittal Article.</td>
</tr>
</tbody>
</table>
SpecsIntact v4.4.2 and newer offers three output options in addition to the SpecsIntact printed Submittal Register. The first, provides output to a **Web Format**, the second, to a **Comma Delimited Format** and the third to a **Microsoft Excel Format**.

All three Output Formats can be generated at the same time or separately. These files require Windows Explorer in order to access them, and are located in the Jobs Working Directory, Exports folder as illustrated.
On the next few pages we’re going to learn how to fix Validation Errors. The Validation Errors are generated through the SpecsIntact Editor when tagging mistakes are made. We’ll illustrate some of the more common Validation Errors and guide you through correcting them.

Before you begin correcting any Reports generated by SpecsIntact you should familiarize yourself with the Helpful Hints listed below! Knowing these techniques will make locating and correcting problems much easier!

Helpful Hints that apply to resolving problems on any of the Reports:

1. *Double-click* any **Section number** within a Report to open that Section in the Editor. Your cursor will be placed at the **Subpart** containing the problem. Tags are automatically hidden when you use the hyperlinking from the Reports, but before making any changes, display the tags on your screen to ensure accuracy.
2. Display the **Marks** to check spacing — each space will be represented by one dot on the screen. Show Marks using the command on the Editor’s **View** menu or the corresponding button on the toolbar.
3. Always check first to see if the problem is the result of a typographical error.
4. Use the second Close button within the Editor to close the report and return you to the Section File, as illustrated below or vice versa.

How do I validate my Section File?

There’s several ways to invoke the Validation. This can be done by saving the Section file, selecting **Tools | Validation** or selecting the **Editor’s Toolbar Validation button**.
Fixing Validation Errors

Resolving Unknown Title

```
Validating D:\SI DATA\JOBS\NEWJOB\pulldata\07 21 16.exe
Date and Time: Wed Jan 27 14:06:08 2010
Subpart: 2.1.2 <Unknown Title>
  Subpart: 2.1.2 - Rules Violation: Subpart has no title (TTL tags missing).
```

Resolving Subpart Has No Title

This error is a result of deleting the Title and Text rather than the entire Subpart. Often this is caused by highlighting incorrectly or editing without tags showing. As illustrated below, see how the beginning DEL tag is just in front of the TTL tag? This is **INCORRECT**! The beginning DEL tag should be in front of the SPT Tag.

**Before:**

```
<STB =1.4.1>1.4.1  <DEL><TTL>Delivery</TTL>
```

```TXT
Deliver materials to the site in original sealed wrapping bearing manufacturer’s name and brand designation, specification number, type, grade, R-value, and class. Store and handle to protect from damage. Do not allow insulation materials to become wet, soiled, crushed, or covered with ice or snow. Comply with manufacturer’s recommendations for handling, storing, and protecting of materials before and during installation.</TXT><DEL>
```
Fixing Validation Errors

There are two ways to correct this problem.

• Place the cursor on the left side of the beginning \textbf{SPT} tag and \textit{press} the \textbf{Shift} and \textbf{Delete keys}
  \textbf{OR}

• Use the \textbf{Double-Click Method} until the selected region encompasses the entire Subpart (SPT Tags), then \textit{press} the \textbf{Delete} key

---

Now that all three agencies require Revisions to show the \textit{Added} and \textit{Deleted} text, SpecsIntact automatically turns them on when creating new projects. Keep in mind the same editing techniques can be used whether you are editing with Revisions or not!
I have looked at this problem in my Section, everything looks fine but I'm still getting a Validation Error for Unknown Title, what could be wrong?

There is one other problem that will result in an Unknown Title error that we haven't covered yet! Verify the Title is surrounded by a set of TTL tags, if not, you will need to insert the tags around the Title.

In this illustration, the Title also has a Submittal Item, so make sure you encompass the SUB tags when you highlight, then select the TTL Button on the Toolbar!

```
BEGINNING
'TTL' Tag is missing!

<SPT=2.1>2.1
<SUB>BLOCK OR BOARD INSULATION</SUB>

ENDING
'TTL' Tag is missing!

<TTL>

<END>
```

```
<SPT=2.1>2.1
<TTL><SUB>BLOCK OR BOARD INSULATION</SUB></TTL>
```
Fixing Validation Errors

Resolving Reference Validation Errors

Resolving ‘SPT’ Cannot Contain ‘ORG’, ‘RID’ or ‘RTL’ Errors

Although the Validation Report reflects a number of errors, inserting one tag can resolve all the problems!

Since the Reference Article can list anywhere from one or more Reference Organizations, you may find yourself correcting the tagging at the beginning, middle or end of the Reference Article.

Illustrated below the Reference Organization is located in the middle of the Reference Article! If this Reference had been the first one listed, there would not be an ending REF tag preceding the beginning ORG tag as shown.

**Before:**

```xml
<REF>
  <ORG>NATIONAL FIRE PROTECTION ASSOCIATION (NFPA)</ORG>
</REF>


<RID>NFFA 31</RID>  <RTL>(2006; Errata 2006; Errata 2007) Installation of Oil Burning Equipment</RTL>


<REF>  <ORG>TECHNICAL ASSOCIATION OF THE PULP AND PAPER INDUSTRY (TAPPI)</ORG>
</REF>
```

**Beginning** Reference ‘REF’ Tag is missing!

**Ending** Reference ‘REF’ Tag is missing!
Fixing Validation Errors

Resolving Reference Validation Errors

Let’s start correcting these problems.

Highlighting To Insert REF Tags

The Reference Organization illustrated is missing the REF tags. By highlighting the entire Reference Organization including its Reference Identifiers and Titles you can insert the REF Tag correctly.

- **Always** start by placing the cursor on the left side of the beginning ORG tag, press and hold the left mouse button highlighting the text until you reach the following beginning REF tag as illustrated,
- Now that you have the area highlighted, release the mouse button then select the REF button on the Tags Bar.

After:

```xml
<RID>NFPA 211</RID>

<RTL>(2006; Errata 2006; Errata 2007) Installation of Oil Burning Equipment</RTL>
<RID>NFPA 31</RID>

<RID>NFPA 54</RID>

<RID>NFPA 70</RID>

<REF> <ORG>TECHNICAL ASSOCIATION OF THE Pulp and Paper Industry (TAPPI)</ORG> </REF>
```
Fixing Validation Errors

Resolving Reference Validation Errors

Now that we have learned how to insert the Reference tag around a Reference Organization at the beginning and middle of the Reference Article, let’s learn how to correct the last one.

Before:

<REF><ORG>U.S. GREEN BUILDING COUNCIL (USGBC)</ORG>


</SPT =1.1><SPT =1.2>1.2 <TTL>DEFINITIONS</TTL>

Remember essentially the steps for correcting this problem are the same as the one on the previous page. The only difference is that this Reference Organization is the last one in the Reference Article.

Highlighting To Insert REF Tags

The Reference Organization illustrated is missing the REF tags. By highlighting the entire Reference Organization including its Reference Identifiers and Titles you can insert the REF Tag correctly.

- **Always** start by placing the cursor on the left side of the beginning ORG tag, **press and hold** the **left mouse button** highlighting the text until you reach the following **ending SPT tag** as illustrated.
- Now that you have the area highlighted, **release** the mouse button then **select** the REF button on the **Tags Bar**.
Fixing Validation Errors

Resolving Reference Validation Errors

By now, you are better equipped to correct these types of Validation Errors. Keep in mind the SpecsIntact Editor verifies several other types of tagging problems that can fail validation. If one of the other validations emerges and you are not sure how to fix them, contact our Technical Support Desk for assistance.
Backup Your Job

Using the Backup function to make a copy of your Job is a good idea any time — especially before executing Revisions, since once these marked changes are accepted, they are permanent and cannot be reversed by the Undo command.

1. From the SI Explorer’s File menu, click Backup/Restore/Manage.
2. From the Backup screen, click the Jobs tab.
3. In the text box, select the Job you want to backup.
4. In the Include in Backup area of the dialog box, check the boxes if you want to backup any Processed Files, PDF Files, and Word Documents that are part of the Job.
5. In the Backup to (Destination) area of the dialog box, choose the Drive from the pull-down list.
6. In the Directory box, click to select the folder in which you want to save the backup.
7. If you want to create a new folder for the backup, add it to the end of the path by typing a backslash (\) and a folder name in the Backup Path text box.
8. In the Backup Type area, select either of the following:
   - Normal Format — Makes individual copies of all the files contained in the Job.
   - Archive (Zip) Format ("Recommended") — Compresses all the files into a single file, requiring less space (required for the e-mailing function on the Restore/Send tab).
9. Checking the box for Delete Existing Files in Backup Directory will delete any type of files (not just previous backups) that already exist in that folder and should be used with extreme caution.
Restoring a Job From a Backup

Whether it’s a Job in progress or a former Job, you may want to take an archived backup you’ve created through SpecsIntact and restore it. In addition, this is the same function you’ll use when adding a downloaded Master to your default Working Directory and the SI Explorer.

1. From the **SI Explorer**, click the **File** menu and choose **Backup/Restore/Manage**
2. Click the **Restore/Manage** tab.
3. In the **Restore From** area of the dialog box, select the **Drive**, **Folder** and **File** you want to restore.
4. The information about the backup chosen will be entered in the boxes on the right side of the screen. You may change the **Name** in the field (a name appearing in red indicates a project with that name already exists).
5. You can choose to:
   - **Overwrite Existing** files, which will completely remove the files under this name in its original Working Directory and replace them with the backup files
   - **Merge with Existing** files, which will both replace all files of the same names with the backup versions, and will also add any additional files in the backup that do not already exist in the Working Directory version.
6. Click **OK**.

You can only change the **Working Directory** destination if you change the **Name** of the project you are restoring.
Executing Revisions

Executing Revisions is one of the last phases of a project.

Make sure to backup the Job before Executing Revisions so you have a backup containing the Revisions!

To accept all the Revisions that you’ve marked throughout the ENTIRE JOB (both additions and deletions):

1. From the SI Explorer, select the Job Folder located in the left pane.
2. Select the File menu, choose Execute Revisions.
3. The Confirm Selections to Execute Revisions Dialog Box will open with all the Sections highlighted.
4. Select OK to Execute Revisions on the Entire Job.

To accept all the Revisions in selected Sections:

1. From the SI Explorer, select the Job folder in the left pane.
2. On the right pane, select one or more Sections.
3. Select Sections Menu and choose Execute Revisions.
4. The Confirm Selections to Execute Revisions Dialog Box will open with only the selected Sections listed and highlighted.
5. Click OK and the marked Revisions in only the Sections selected will become permanent.

Once the options listed above are done, the changes become permanent. These changes will now appear as regular text and will carry the attributes of the tags that enclose them.

After you Execute Revisions, the files that have been permanently changed by this function are temporarily displayed in the left pane of the SI Explorer in a folder called Revised Files, located under the Job folder. These are the actual Section files, so do not delete them from this folder or they will be permanently removed from your Job!
Job Checklist

- Make sure you have the most recent **Software** and **Masters**, and, if necessary, download newer versions from the SpecsIntact web site.
- Print the **Master Table of Contents with Scope** (which lists the Section numbers, Titles, and a brief description of each Section in the Master).
- Give this list to your project manager so the Sections necessary for the Job can be determined.
- When the project manager returns the list, print the Sections requested. Before printing them, ask whether they should show **English** or **Metric** Units of Measure, and make sure that you also show the **Notes**.
- Create the Job and add the Sections requested. Remember that the software will automatically add two Sections — **01 33 00** and **01 42 00** — which are necessary for processing the Job.
- Begin editing, and remember to always edit with **Tags** visible on the screen. You can also toggle on and off the **Marks**, **Notes**, and **Revisions** (if you’re using Revisions). **Save** your Section often as you edit. When you do, it will produce a **Validation Report** that will flag certain mistakes (the Validation Report can be turned on or off from **Tools | Options | Save** screen).
- Use the **Process & Print/Publish** function to generate the **Reports** and perform **Reconciliation** (processing the entire Job for accuracy), and correct any errors or discrepancies found. Don’t forget to rerun the reports after any changes and until all findings are resolved.
- Run a **Spell Check** after all changes are made.
- Visually check the formatting by toggling off all the screen elements. Check spacing and lines. Generally, you should have one blank line between paragraphs. Turn Tags and Marks back on before deleting any blank lines.
- Create the finished Job (selecting all the Reconciliation options) choosing the output file type desired — SI print (**.prn**) files can be sent directly to the printer, while **PDF** and **Word** files are only produced electronically. These files can be printed to paper through the SI Explorer. Remember the **Submittal Register** is not visible in the SI Explorer (except in PDF), nor is an .rtf cover sheet, and they cannot be produced if you are using Word for your output format.
- Don’t forget to make a **Backup** of your Job.
Wrap up

“I think I am prepared to use SpecsIntact, but I have a few questions. Can I call tech support for assistance?”
— Shirley in Shreveport

Of course you can! The SI Tech Support staff will be happy to answer your questions. It’s better to ask before you make a serious mistake than to wait until you’ve spent hours working on a Job, only to find out you need hours more to correct it. Don’t forget to use the Help menu as you work, and to use the SI web site as a resource as well.

What you learned from this chapter:

♦ How to use tools, shortcuts and other techniques to edit more efficiently.
♦ There are specific rules regarding use of symbols and capitalization with the text.
♦ Using the results from the QA Reports help you locate problems in the Sections and fix them.
♦ Helpful information is provided when the various Lists are generated during processing.
♦ An archived Job can be restored using the SI Explorer.
♦ Using a Job checklist can help you make certain you’ve completed all the necessary steps to finish your Job.
Sally hopes you have found her guided tour helpful. If you have any comments or feedback regarding this guide, please feel free to pass them along to SpecsIntact Tech Support.